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AUTOCAD SORULARI 

 

1. Çizim ekranı etrafında yer alan içerisinde ilgili komutların bulunduğu araç 

çubuklarının diğer adı nedir? 

 a-) Standard menü  b-) Drawing  c) Toolbars  d) Export 

 2. Aşağıdakilerden hangisi File menüsüne ait yeni bir çizim dosyası açma komutudur?  

a) Open b) New c)Close d) Undo  

3. Çizim ekranının sol alt köşesinde bulunan aşağıdaki şekil nedir?  

a) Yatay kaydırma çubuğu b) Komut satırı c) Koordinat sistemi X d) Düşey kaydırma çubuğu 

 4. Ekranın altında bulunan durum çubuğu komutlarından hangisi nesne yakalama 

modunu açar veya kapatır?  

a) Grid b) Osnap c)Snap d) Move  

5. Aşağıdakilerden hangisi Draw menüsüne ait komuttur?  

a) Leader b) Zoom c)Trim d) Arc  

6. Aşağıdakilerden hangisi Modify menüsüne ait komuttur?  

a) Mirror b) Diameter c)Regen d) Acad  

7. Aşağıdakilerden hangisi ölçülendirme menüsüdür? 

 a) View b) Dimension c)Polyline d) Array  

8. Aşağıdakilerden hangisi görüntü çizgilerini gizleyen view menüsü komutudur?  

a) Display b) Shade c)Clean d) Hide  

9. Aşağıdakilerden hangisi çizimi yakınlaştıran veya uzaklaştıran görüntü komutudur? 

 a) View b) Zoom c)Pan d) Block  

10. Aşağıdakilerden hangisi işlemi geri alan Edit menüsüne ait komuttur? 

 a) Undo b) Table c)Clear d) Hatch  

11. Daha önceden kaydedilmiş bir dosyayı çağıran komut hangisidir? 
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 a) Close b) Send c)Open d)  

12. Aşağıdakilerden hangisi insert menüsüne ait çizimde bloklama işlemi yapan 

komuttur? 

 a) Layer b) Offset c) Copy d) Block 

 13. Aşağıdakilerden hangisi Draw menüsüne ait çokgen oluşturma komutudur?  

a) Polygon b) Plot c) Reganel d) Update 

 14. Açısal ölçülendirme yapan komut hangisidir?  

a) Radius b) Angular c) Open d) Donut  

 

15. Aşağıdakilerden hangisi Modify menüsüne ait taşıma komutudur? 

 a) Filet b) Copy c) Explode d) Move 

 16. Cizim sırasında noktaların tüm koordinat değerlerinin orijine göre verilen 

koordinat sistemi nedir?  

a) Artımsal Koordinat S. b) Sırasal Koordinat S. c) Mutlak Koordinat S. d) Açısal Koordinat 

S. 

 17. Aşağıda LINE komutu uygulanarak A noktası seçilen ve yatayla 60 derece açı 

yaparak açısal koordinat sistemine göre AB doğrultusunda,100 birim uzunluğunda 

doğruyu çizen komut satırı aşağıdakilerden hangisidir? 60 derece A  

18. Line, circle, arc komutlarıyla çizilenleri eşit aralıklarla bölmeyi sağlayan komut 

aşağıdakilerden hangisidir?  

a) Erase b) Divide c) Masure d) Scale 

 19. Çizgilerin birbirinden koparılmasını sağlayan komut aşağıdakilerden hangisidir ?  

a) Extend b) Union c) Trim d) Hatch  

20. Dosyanın aynısını başka bir adla kopyalayan komut aşağıdakilerden hangisidir?  

a) Copy to clipboard b) Copy c) Save d) Save as  

21- Render’da gölge oluşturabilmek için aşağıdakilerden hangisi kullanılmalıdır?  

a)Material b)Light c)Background d)Fog 
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2 2- AutoCad’te kağıda çıktı almak için hangi komut kullanılır?  

a)Plot b)Preview c)Publish d)Layout  

23- Toolbar’lar aşağıdakilerden hangisi ile açılabilir?  

a)View-Toolbars b)View-Display c)View-Zoom d)View-Regen  

24- Aşağıdaki shade modlarından hangisi cismi gölgelendirilmiş dolu obje olarak 

gösterir? 

 a)2D wireframe b)3D wireframe c)Hidden d)Flat Shaded 

2 5- Aşağıdaki zoom’lardan hangisi eşzamanlı büyültme-küçültme yapar? 

 a)Pan b)Realtime c)Previous d)Window 

2 6- Tolerans simgesi hangi konu ile ilgilidir?  

a)Design Center b)Insert c)Dimension d)Editing  

27- Alan,hacim ve koordinat bilgilerini veren komutlar hangi toolbar içinde bulunur?  

a)Dimension b)Shade c)Modify d)Inquiry      

28- Aşağıdaki komutlardan hangisini kullanarak, seçili iki boyutlu cismi belli bir yönde 

sündürebiliriz? 

 a)Scale b)Stretch c)Extend d)Measure  

 

29- Chamfer komutunun görevi nedir? 

 a)İki çizgi yuvarlatılarak birleştirilir b)Objelerin boyutunu büyütüp,küçültür c)Köşelerden 

pah kırma işlemini yapar d)Objeleri döndürmek için kullanılır 

 30- Aşağıdaki komutlardan hangisi Lengthen komutunda çizgi uzatma yöntemlerinden 

biri değildir?  

a)Delta b)Dynamic c)Percent d)Extend 

 31- İstenilen objeyi (çizgi,yay vb.) belirlediğimiz sayıda nokta veya blok kullanarak eşit 

aralıklarla işaretlemeyi sağlayan komut aşağıdakilerden hangisidir? 

 a)Divide b)Measure c)Array d)Hepsi  
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32- Ölçülendirmede yazının altında kalan çizgiye ne ad verilir?  

a)Dimension Line b)Extension Line c)Baseline d)Leader  

33- Ölçülendirmedeki ok başlarına ne ad verilir?  

a)Leader b)Arrow Head c)Mark d)Fit  

34- Boundary komutunun kısayolu nedir?  

a)bo b)b c)ob d)bou 

 35- Alan ölçme komutu olan Area’nın kısayolu nedir? 

 a)aa b)ar c)a d)are  

36- Komut iptali yapan kısayol tuşu hangisidir? 

 a)Mouse sağ tuş b)Space c)Esc d)Tab  

37- Belirlenen açılarda imlecin takılarak çizim yapmasını sağlayan komut (koordinat 

sistemi) hangisidir? 

 a)Orthogonal b)Polar c)İzometrik d)Layout  

38- Oran belirterek büyütüp,küçültme yapabildiğimiz zoom hangisidir? 

 a)Pan b)Window c)Scale d)Extent 

 39- Merkezle büyüklüğü kontrol edilebilen bir dörtgenle yaklaşma yapabilen zoom 

hangisidir? a)Extent b)Window c)Dynamic d)Center  

40- Aşağıdakilerden hangisi 3D...........boşluğuna koyularak bir komut oluşturmaz?  

a)Mirror b)Array c)Rotate d)Stretch  

41. Perspektif çizim yapabilmemiz için Drafting Settings tablosundan hangisini seçmeliyiz?  

a) Grid Snap b) Rectengular Snap c) Isometric Snap d) Polar Snap  

42. Herhangi bir üçgenin içinde, kenarlarına teğet olacak şekilde tek bir çember çizmek için 

Draw menüsünün Circle komutunda hangi seçenek uygulanır? 

 a) 3 points b) Tan, Tan, Tan c) Tan, Tan, Radius d) 2 points  

43. Çıktı alma komutu olan Plot hangi araç kutusundadır ? 
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 a) Standart toolbar b) Properties toolbar c) Draw toolbar d) Modify toolbar  

44. Çizilen şekilleri çizim ekranında sağa-sola, yukarı-aşağı sürüklemeyi sağlayan komut 

hangisidir? 

 a) Move b) Offset c) Pan d) Array  

45. Birbirini kesmeyen ya da temas etmeyen doğru parçalarını uzatarak kesişmesini sağlayan 

komut hangisidir? 

 a) Line b) Extend c) Trim d) Redo  

46. Kesişen iki doğru köşesine veya katı modeller üzerinde bulunan köşelere pah kıran komut 

hangisidir?  

a) Radüs b) Edit c) Chamfer d) Fillet  

47. Çift çizgi ya da daha fazla çizgi çizmemizi sağlayan komut aşağıdakilerden hangisidir? 

 a) Line b) Polyline c) Multiline d) Construction line  

48. Sınırları belli kapalı bir alanı belli bir desenle taramak için kullanılan komut 

aşağıdakilerden hangisidir? 

 a) Color b) Pattern c) Regionve d) Hatch 

 49. Seçilen objenin belirlenen iki nokta arasında kırılmasını sağlayan komut hangisidir?  

a) Break b) Divide c) Trim d) Extend  

50. İçi dolu daire halkası çizen Draw menüsü komutu hangisidir?  

a) Circle b) Donut c) Arc d) Elips  

51. Kesişen iki doğru köşesine veya katı modeller üzerinde bulunan köşelere yuvarlatma 

yapan komut nedir? 

 a) Chamfer b) Edit c) Offset d) Fillet  

52. Belirli bir mesafe girerek çizgileri ötelemeye yarayan komut aşağıdakilerden hangisidir?  

a) Line b) Polyline c) Move d) ofset 

53. Çizilen bir objeyi 5 kat büyültmek istenildiğinde aşağıdakilerden hangi komut işlemini 

yapılmalıdır?  

a) Scale’ den 5 b) Stretch’ den 5 c) Scale’ den 1/5 d) Stretch’ den 1/5  
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54. Kesişebilecek çizgilerin uçlarını uzatmak için kullanılan komut hangisidir?  

a) Extend b) Union c) Ray d) Trim  

55. Çizilen objenin çiziminin başka bir yerinde veya başka bir çizim dosyasında kullanılmak 

üzere blok oluşturan komut hangisidir? 

 a)İnsert b)Extend c)Block d) Redo  

56. Seçilen objelerin belirli bir refarans noktasına göre istenilen açıda döndürülmesini 

sağlayan komut hangisidir?  

a) Mirrör b) Rotate c) Move d) Change 

 57. Çokgen çizmek için kullandığımız Draw menüsü komutu nedir?  

a) Polyline b) Polygon c) Offset d) Rectenqular  

58. İzometrik izdüşümü elde etmek için cismin iki kenarı yatayla kaç derecelik eşit açı 

yapacak şekilde düzlem ölçüsüne yerleştirilir? 

 a) 30 derece b) 60 derece c) 45 derece d) 20 derece  

59. İzometrik ölçülendirme yapabilmek için araç çubuğundan hangi seçenek tercih edilir? 

 a) Angular Dimension b) Ordinate Dimension c) Aligned Dimension d) Quick Dimension 

 60. Çizilen nesneleri katı modelleme öncesi birleştirmek için kullanılan Draw menüsüna ait 

komut hangisidir? 

 a) Stretch b) Command c) Union d) Region  

 61- Trim komutu aşağıdakilerden hangisine uygulanamaz?  

a)Line b)Arc c)Pline d)Face  

62- Extend komutu ne yapar?  

a)Uzatma b)Budama c)Silme d)Yükseltme  

63- Bir cismin simetrisini almak için hangi komut uygulanır? 

 a)Copy b)Mirror c)Move d)Blok 

 64- Yeni bir cisim oluşturan üretim komutları hangi menü altındadır?  

a)Tools b)Draw c)Modify d)Format 
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6 5- Düzenleme komutları hangi menüdedir?  

a)View b)Tools c)Format d)Modify 

 66- Autocad’de dosya seçim kullanıcı tercihleri gibi seçeneklerin ayarlandığı komut 

hangisidir? 

 a)Chage b)Proporties c)Option d)İnsert  

67- Circle komutunun kısa yolu hangisidir?  

a)c b)co c)ci d)Cr  

68- Aşağıdakilerden hangisi (enter)’in yerini görmez? 

 a)Sol tuş b)Sağ tuş c)Space bar d)Hiçbiri 

6 9- Hangisi hepsi anlamına gelir?  

a)Select b)None c)Object d)All  

70- Hangisi açı anlamına gelir?  

a)Scale b)Rotate c)Base d)Angle  

 

71- “Edge” in karşılığı nedir?  

a)Kesmek b)Seçmek c)Kenar d)Nesne 

 72- “Boundary” in karşılığı nedir?  

a)Sınır b)Uzatmak c)Budamak d)Patlatmak  

73- Hangisiyle bir merkez etrafında dairesel kopyalama yapılır?  

a)Copy b)Move c)Array d)Align  

 

74. Autocad'de çizgi çizmemizi sağlayan komut aşağıdakilerden hangisidir?  

a-) circle b-) trim c-) line d-) polygon 

 

75. Autocad' de yazı yazmamızı sağlayan komut aşağıdakilerden hangisidir?  

a-) text b-) text style c-) hatch d-) erase 
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76. Erase komutu autocad'de aşağıdakilerden hangisi yapmaktadır? 

a-) obje silme b-) radus çizme c-) daire çizme d-) çizgi çizme 

 

77. Çizilmiş olan parçayı hem döndürebildiğimiz hem de tersini yansıtabildiğimiz komut 

nedir? 

a-) rotate b-) array c- ) mirror d-) region 

 

78. Çizilmiş olan bir parçayı block yapmak için aşağıdakilerden hangi komut kullanılır? 

a-) make block b-) paste c-) region d-) copy with base point  

 

79. Autocad'de çizgileri birbirinden koparılmasını sağlayan komut aşağıdakilerden 

hangisidir ? 

a-) extend b-) union c-) trim d-) hatch 

 

80. Yakalama modlarından ( O Snap) çizginin dikine yakalamayı sağlayan yardımcı 

mod aşağıdakilerden hangisidir? 

a- insert b-) Nearest c-) Perpendicular d-) Node 

 

81. Yakalama modlarından node ne işe yarar? 

a-) dikine yakalar b-) paralel yakalar c-) nokta yakalar d-) teğet yakalar 

 

82. Autocad' de tarama yapmamızı sağlayan komut aşağıdakilerden hangisidir? 

a- ) text b-) hatch  c-) region d-) line 

 

83. Autocad' deki copy komutunu kullanırken kopyalamayı tekrar etmek için ne 

yapmak gerekir? 

a-) multiple b-) choice c-) erase d-) hiçbir şey gerekmez 

 

84. Belirli bir mesafe girerek çizgileri ötelemeye yarayan komut aşağıdakilerden 

hangisidir? 

a-) line b-) offset c-) move d-) polyline 

 

85. Autocad'deki donut ( çift daire içini boyayarak çizen ) komutu hangi menü içerisinde 

yer almaktadır? 

a-) format menüsünde b-) draw menüsünde  c-) modify menüsünde d-) dimension 

menüsünde  
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86. Autocad' de Ucs ne işe yarar? 

a-) Sadece orjindir b-) Orjindir ve kullanıcı koordinat sistemidir c-) Çizgileri siler d-) hiç bir 

işe yaramaz 

 

87. Dosyamın aynısını başka bir adla kopyaladığm komut aşağıdakilerden hangisidir? 

a-) copy to clipboard b-) copy c-) save d-) save as 

 

88. Çizilen bir objeyi 5 kat büyültmek istenildiğinde ne yapılmalıdır? 

a-) scale' den 5/1 b-) stretch' den 5/1 c-) scale' den 1/5 d-) stretch' den 5/1 

 

89. Autocad' de objeleri döndürmeyi sağlayan komut aşağıdakilerden hangisidir? 

a-) mirror b-) scale c-) donut d-) rotate 

 

90. Autocad' deki sivri köşeleri radüs atma komutu aşağıdakilerden hangisidir? 

a-) edit text b-) filet c-) chamfer d-) circle 

 

91. Dimension style menüsü autocad'de ne işe yarar ? 

a-) Ölçülendirme yapılır b-) Ölçülendirme ayarı ve yeni ölçülendirme karakterleri yaratılır 

d-) Sadece ölçülendirme ayarı yapılır d-) Dimension menüsünü açmaya yarar 

 

92. Çizilen şekilleri çizim alanında sağa-sola, yukarı-aşağı sürüklemeyi sağlayan komut 

hangisidir? 

a-) move b-) offset c-) pan d-) array 

 

93. Çizilen tüm resimleri ekranda görmemi sağlayan zoom komutu klavyeden nasıl 

kullanılır? 

a-) Zoom-dynamic b-) Zoom-v c-) Zoom-A d-) Zoom- P 

 

94. Çizilmiş iki daire arasına radüsü bilinen başka bir daire çizmek için ne yapılmalıdır? 

a-) C ? ttr ? radüs yazılır ? daireler seçilir ? b-) c ? ttr ? daireler seçilir ? radüs yazılır ? 

c-) c ? ttt ? daireler tıklanır ? radüs yazılır ? d-) c ? tr ? daireler pencere içine alınır ? r ? 

 

95. Çıktı alma komutu olan plot hangi araç kutusundadır ? 

a-) standart toolbar b-) properties tollbar c-) draw tolbar d-) modify toolbar 

 

96. Autocad' de çift çizgi ya da daha fazla çizgi çizmemizi sağlayan komut 

aşağıdakilerden hangisidir? 

a-) line b-) polyline c-) multiline d-) construction line 
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97. Autocad' de çizgileri birbirine uzatılmasını sağlayan komut aşağıdakilerden 

hangisidir ? 

a-) extend b-) break c-) break at point d-) spline  

 

98. Autocad' de üçgen, beşgen gibi çokgenleri çizmemizi sağlayan komut 

aşağıdakilerden hangisidir? 

a-) polyline b-) polygon c-) multiline d-) move 

 

99. Ölçülendirme ayarlarının içinde kendi yarattığımız bir karakterin sadece oklarını, 

yazı yüksekliği vb. ayarlarını 4 kat büyütmek istediğimizde aşağıdakilerden hangisini 

kullanırız. 

a-) Dimension style-Text bölümünden b-) Dimension style-Fit bölümünden 

c-) Dimension style-Primary units bölümünden d-) Dimension style-Lines and arrows  

 

100. Bir objenin bütün özelliklerini tanımlayan komut aşağıdakilerden hangisidir? 

a-) match properties b-) dimension style c-) properties d-) insert 

 

 

101. Autocad ekranındaki çizimimizi resim formatında nasıl kaydederiz? 

a-) Tools/display imaj/save b-) edit/cut c-) file/save d-) modify/rotate 

 

102. Tablo oluşturmak için hangi komutu kullanırız? 

a-) table b-) draw c-) insert d-) select 

 

 

103.       Çizim ekranı etrafında yer alan içerisinde ilgili komutların bulunduğu araç 

çubuklarının diğer adı nedir? 

a-) Standard menü     b-) Drawing                          c) Toolbars                         d) Export 

 

104.       Aşağıdakilerden hangisi File menüsüne ait yeni bir çizim dosyası açma komutudur? 

a) Open                                 b) New                                  c)Close                                  d) 

Undo 

 

105.       Ekranın altında bulunan durum çubuğu komutlarından hangisi nesne yakalama 

modunu açar veya kapatır? 

a) Grid                                   b) Osnap                               c)Snap                                  d) 

Move 

 

 106       Aşağıdakilerden hangisi Draw menüsüne ait komuttur? 

a) Leader                              b) Zoom                                               c)Trim                   d) Arc 
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 107       Aşağıdakilerden hangisi Modify menüsüne ait komuttur? 

a) Mirror                             b) Diameter                          c)Regen                                d) Acad 

 

 108       Aşağıdakilerden hangisi ölçülendirme menüsüdür? 

a) View                                 b) Dimension                      c)Polyline                             d) Array 

 

 109       Aşağıdakilerden hangisi görüntü çizgilerini gizleyen view menüsü komutudur? 

a) Display                             b) 

Shade                                              c)Clean                                 d) Hide 

 

 110.       Aşağıdakilerden hangisi çizimi yakınlaştıran veya uzaklaştıran görüntü komutudur? 

a) View                                 b) Zoom                               c)Pan                                     d) 

Block 

 

 111.    Aşağıdakilerden hangisi işlemi geri alan Edit menüsüne ait komuttur? 

a) Undo                                b) Table                                c)Clear                                  d) Hatch 

 

 112.    Daha önceden kaydedilmiş bir dosyayı çağıran komut hangisidir? 

a) Close                                b) Send                                 c)Open                                  d) 

Donut 

  

113.    Aşağıdakilerden hangisi insert menüsüne ait çizimde bloklama işlemi yapan komuttur? 

a) Layer                                               b) Offset                               c) Copy                 d) Block 

 

 114.    Aşağıdakilerden hangisi Draw menüsüne ait çokgen oluşturma komutudur? 

a) Polygon                           b) Plot                                   c) Reganel                            d) 

Update 

 

 115.    Açısal ölçülendirme yapan komut hangisidir? 

a) Radius                              b) Angular                           c) Open                                 d) Donut 

 

 116.    Aşağıdakilerden hangisi Modify menüsüne ait taşıma komutudur? 

a) Filet                                   b) Copy                                c) Explode                            d) Move 

 

 117.    Cizim sırasında noktaların tüm koordinat değerlerinin orijine göre verilen koordinat 

sistemi nedir? 

a) Artımsal Koordinat S.   b) Sırasal Koordinat S.      c) Mutlak Koordinat S.    d) Açısal 

Koordinat S. 

 

118.    Line, circle, arc komutlarıyla çizilenleri eşit aralıklarla bölmeyi sağlayan komut 

aşağıdakilerden hangisidir? 

a) Erase                                        b) Divide                              c) Masure                             d) 

Scale 

119.    Çizgilerin birbirinden koparılmasını sağlayan komut aşağıdakilerden hangisidir ? 
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a) Extend                     b) Union                               c) Trim                                                d) 

Hatch 

 

 120.    Dosyanın aynısını başka bir adla kopyalayan komut aşağıdakilerden hangisidir? 

a) Copy to clipboard                 b) Copy                                                c) 

Save                                  d) Save as 

 

121.    Donut ( çift daire içini boyayarak çizen ) komutu hangi menü içerisinde yer 

almaktadır? 

a) Format menüsü     b) Draw menüsü c) Modify menüsü              d) Dimension menüsü 

 

 122.    Çizimlerin köşelerine radüs atma komutu aşağıdakilerden hangisidir? 

a) Edit text                   b) Chamfer                          c)  Filet                                 d) Circle    

 

123.    Verilen noktalardan geçen bir spiral şeklinde eğriler oluşturmak amacıyla kullanılan 

komut hangisidir? 

a) Spline                      b) Arc                                   c)  Yay                                   d) Trace    

 

 124.    Doğrusal veya dairesel çoğaltma işlemini gerçekleştiren komut hangisidir? 

a) Change                    b) Array                              c) Polyline                            d) Circle    

 

 125.    Yapılan tasarımlarda tek ya da çok satırlı yazı yazma komutu hangisidir? 

a) Angle                        b) Dedit                               c)  Text                                  d) Metin    

 

126.    Perspektif çizim yapabilmemiz için Drafting Settings tablosundan hangisini 

seçmeliyiz? 

a) Grid Snap                                b) Rectengular Snap          c) Isometric Snap              d) 

Polar Snap 

  

127.    Herhangi bir üçgenin içinde, kenarlarına teğet olacak şekilde tek bir çember çizmek 

için Draw menüsünün Circle komutunda  hangi seçenek uygulanır?  

a) 3 points                    b) Tan, Tan, Tan               c) Tan, Tan, Radius           d) 2 points 

 

128.    Çıktı alma komutu olan Plot hangi araç kutusundadır ? 

a) Standart toolbar   b) Properties toolbar           c) Draw toolbar                   d) Modify 

toolbar 

 

 

129.    Çizilen şekilleri çizim ekranında sağa-sola, yukarı-aşağı sürüklemeyi sağlayan komut 

hangisidir? 

a) Move                       b) Offset                               c) Pan                                   d) Array 

 

 

130.    Birbirini kesmeyen ya da temas etmeyen doğru parçalarını uzatarak kesişmesini 

sağlayan komut hangisidir? 
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a) Line                                        b) Extend                            c) Trim                                  d) 

Redo    

  

131.    Kesişen iki doğru köşesine veya katı modeller üzerinde bulunan köşelere pah kıran 

komut hangisidir? 

a) Radüs                      b) Edit                                  c)  Chamfer                         d) Fillet    

  

132.    Çift çizgi ya da daha fazla çizgi çizmemizi sağlayan komut aşağıdakilerden hangisidir? 

a) Line                                          b) Polyline                            c) Multiline                         d) 

Construction line 

 

133.    Sınırları belli kapalı bir alanı belli bir desenle taramak için kullanılan komut 

aşağıdakilerden hangisidir? 

a) Color                        b) Pattern                             c) Regionve                          d) Hatch 

 

134.    Seçilen objenin belirlenen iki nokta arasında kırılmasını sağlayan komut hangisidir? 

a) Break                      b) Divide                              c)  Trim                                  d) Extend    

 

  135.    İçi dolu daire halkası çizen Draw menüsü komutu hangisidir? 

              a) Circle                        b) Donut                               c)  Arc                                   d) 

Elips   

 

 136.    Kesişen iki doğru köşesine veya katı modeller üzerinde bulunan köşelere yuvarlatma 

yapan komut nedir? 

a) Chamfer                                 b) Edit                                  c)  Offset                               d) 

Fillet    

 

137.    Başlangıç noktası belirlenen tek yönde sonsuz çizgi çizen Draw menüsü komutu nedir? 

a) Line                                          b) Polygon                            c)  Ray                                  d) 

Pline    

  

138.    İçi dolu daire halkası çizen Draw menüsü komutu hangisidir? 

a) Circle                        b) Donut                               c)  Arc                                   d) Elips   

  

139.    Kesişebilecek çizgilerin uçlarını uzatmak için kullanılan komut hangisidir? 

a) Stretch                     b) Union                               c)  Ray                                  d) Trim   

  

140.    Çizilen objenin çiziminin başka bir yerinde veya başka bir çizim dosyasında 

kullanılmak üzere blok oluşturan komut hangisidir? 

a) İnsert                                      b) Extend                             c) 

Block                                               d) Redo    

  

141.    Seçilen objelerin belirli bir refarans noktasına göre istenilen açıda döndürülmesini 

sağlayan komut hangisidir? 

a) Mirrör                       b) Rotate                             c) Move                                d) Change    
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142.    Çokgen çizmek için kullandığımız Draw menüsü komutu nedir? 

a) Polyline                    b) Polygon                           c)  Offset                               d) 

Rectenqular   

  

143    İzometrik izdüşümü elde etmek için cismin iki kenarı yatayla kaç derecelik eşit açı 

yapacak şekilde düzlem ölçüsüne yerleştirilir? 

a) 30 derece                                b) 60 derece                         c)  45 derece                         d) 20 

derece     

  

144.    İzometrik ölçülendirme yapabilmek için araç çubuğundan hangi seçenek tercih edilir? 

a) Angular Dimension               b) Ordinate Dimension      c)  Aligned Dimension      d) 

Quick Dimension   

 

145.    Değişik tip ve özellikte yazı yazmamız amacıyla kullanılan komut hangisidir? 

a) Print                                         b) Text                                c)  Plot                                  d) 

Drawing    

  

146.    Dimension menüsü içerisinde bulunan komutlar hangi amaç için kullanılırlar? 

a) Düzenleme                             b) Çizim yapma                  c)  Yazma                             d) 

Ölçülendirme    

  

147.    Modiyf menüsü içerisinde bulunan komutlar hangi amaç için kullanılırlar? 

a) Düzenleme                             b) Çizim yapma                  c)  Yazma                             d) 

Ölçülendirme 

  

148    Çizgi kalınlıklarını değiştiren komut hangisidir? 

a) Length                     b) Linetype                          c)  Lineweight                     d) Ltscale 

 

149  Autocad’de daire çizmemizi sağlayan komut aşağıdakilerden hangisidir? 

a) Circle                                      b) trim                                   c) line                                    d) 

polygon 

  

150.  Autocad’de yay çizmemizi sağlayan komut aşağıdakilerden hangisidir? 

a) Circle                                       b) trim                                   c) arc                                    d) 

polygon 

  

151.  Autocad’de filet komutun kısa yazılımı  aşağıdakilerden hangisidir? 

a) tr                                              b) m                                       c) l                                         d) 

pl 

  

152.  Autocad’de array komutun kısa yazılımı aşağıdakilerden hangisidir? 

a) aa                                             b) ay                                      c) ya                                      d) 

ar 
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153.  Autocad’de mirror komutun kısa yazılımı aşağıdakilerden hangisidir? 

a) mm                                          b) m                                       c) mi                                      d) 

mr 

  

154.  Autocad’de paht kırma  işlemini gerçekleştiren  komut aşağıdakilerden hangisidir? 

a) Circle                                       b) chamfer                          c) line                                    d) 

polygon 

  

155.  Autocad’de çizimi döndürme sağlayan komut aşağıdakilerden hangisidir? 

a) Circle                                       b) trim                                   c) rotate                               d) 

polygon 

  

  
156.           Autocad’ de yazı yazmamızı sağlayan komut aşağıdakilerden hangisidir? 

a) Text                                         b)  text style                         c) hatch                                d) 

Erase 

  

157.           Autocad’ de nokta şekillerinin ayarı nereden yapılır? 

a) format-text style                   b) format- Multiline           c) format- 

linetype             d) format-point style 

  

158.           Erase komutu autocad’de aşağıdakilerden hangisi yapmaktadır? 

a) obje silme                               b) radus çizme                     c) daire çizme                      d) 

çizgi çizme 

  

159.         Pah kırma komutu olan chamfer komuta girildikten sonra nasıl kullanılır ? 

a) Obje seç ? D ? mesafe yazılır ? çizgiler tıklanır 

b) D ? tr ? mesafe yazılır ? çizgiler tıklanır 

c) D ? 1 mesafe yazılır ? ikinci mesafe yazılır ? çizgiler sırayla tıklanır  

d) D ? mesafe yazılır ? çizgiler tıklanır 

  

160.         Array komutunda dikdörtgensel çoğaltma yapmak için komuta girildikten 

sonra neler yapılmalıdır? 

a) R ? sütun sayısı ? satır sayısı ? sütun aralığı ? satır aralığı 

b) R ? satır sayısı ? sütun sayısı ? satır aralığı ? sütun aralığı 

c) Obje seç ? R ? satır sayısı ? sütun sayısı ? satır aralığı ? sütun aralığı 

d) Obje seç ? R ? sütun sayısı ? satır sayısı ? sütun aralığı ? satır aralığı 
  

161.           Line, circle, arc gibi çizgileri istenilen sayı kadar bölmeyi sağlayan komut 

aşağıdakilerden hangisidr? 

a)  erase                                       b) divide                               c) measure                           d) 

line 

  

162.         Çizilmiş olan parçayı hem döndürebildiğimiz hem de tersini yansıtabildiğimiz 

komut nedir? 
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a)  rotate                                      b) array                                 c) 

mirror                             d) region 

  

163.         Çizilmiş olan bir parçayı block yapmak için aşağıdakilerden hangi komut 

kullanılır? 

a) insert block                            b) paste                                 c) 

region                                d) copy with base point 

 

 

164.           Line, circle, arc gibi çizgileri eşit aralıklarla bölmeyi sağlayan komut 

aşağıdakilerden hangisidir? 

a)  break                                      b) 

divide                               c) measure                           d) line 

  

165.           Block olan objeleri rectangle, polygon gibi ya da yazı veya ölçülendirmeleri 

parçalayarak block halinden çıkartan komut aşağıdakilerden hangisidir? 

a)  region                                      b) extend                              c) 

explode                            d) extrude 

  

166.           Autocad’de çizgileri birbirinden koparılmasını sağlayan komut 

aşağıdakilerden hangisidir? 

a) Extend                                     b) union                                c) 

trim                                  d) hatch 

 

 

167.           Yakalama modlarından ( O Snap) çizginin dikine yakalamayı sağlayan 

yardımcı mod aşağıdakilerden hangisidir? 

a)  insert                                       b) Perpendicular               c) 

Nearest                             d) Node 

  

168. Seçilmiş olan objeyi bütün özelliğiyle aynı nitelikteki başka bir objeye aktararak 

değiştiren komut aşağıdakilerden hangisidir? 

a) properties                                       b) match propeties            c) edit 

text                            d) measure 

  

169.           Yakalama modlarından node ne işe yarar? 

a) dikine yakalar                        b) paralel yakalar                               c) nokta 

yakalar                                d) teğet yakalar 

 

170. Autocad’ de tarama yapmamızı sağlayan komut aşağıdakilerden hangisidir? 

a) text                                                  b) hatch                                c) region                              

  d) line 

  

171.           Autocad’ deki copy komutunu kullanırken kopyalamayı tekrar etmek için ne 

yapmak gerekir? 
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a) Multiple                                 b) choice                               c) erase                                 d) 

hiçbir şey gerekmez 

  

172.           Belirli bir mesafe girerek çizgileri ötelemeye yarayan komut aşağıdakilerden 

hangisidir? 

a) line                                           b) ofset                                 c) move                                d) 

polyline 

 

173.           Autocad’deki donut ( çift daire içini boyayarak çizen ) komutu hangi menü 

içerisinde yer almaktadır? 

a) format menüsünde                              b) draw menüsünde           c) modify 

menüsünde       d) dimension menüsünde 

 

 

174.           Autocad’ de Ucs ne işe yarar? 

a) Sadece orjindir                       b) Orjindir ve kullanıcı koordinat sistemidir 

c) Çizgileri siler                            d) hiç bir işe yaramaz 

  

175.           Dosyamın aynısını başka bir adla kopyaladığm komut aşağıdakilerden 

hangisidir? 

a) copy to 

clipboard                 b)  copy                                c)  save                                 d)  save as 

  

176.           Çalışılan sayfa içinde çizimleri başka bir dosyaya aktarabildiğim komut 

aşağıdakilerden hangisidir? 

a) inset block                              b) make block                     c) save as                             d) 

match properties 

 

 177           Çizilmiş olan parçayı çekiştirerek üzerinde değişiklik yapmamaı sağlayan 

komut aşağıdakilerden hangisidir? 

a) stretch                                    b) scale                                 c) spline                                d) 

sallama 

  

178.           Çizilen bir objeyi 5 kat büyültmek istenildiğinde ne yapılmalıdır? 

a) scale’ den 5/1                       b)  stretch’ den 5/1             c)  scale’ den 

1/5                 d)  stretch’ den 5/1 

  

179.           Çizilen bir objeyi 5 kat büçültmek istenildiğinde ne yapılmalıdır? 

a) scale’ den 5/1                        b)  stretch’ den 5/1             c)  scale’ den 

1/5                d)  stretch’ den 5/1 

  

  

180.           Autocad’ de objeleri istenilen ölçüde büyütme veyahutta küçültme  sağlayan 

komut aşağıdakilerden hangisidir? 

a) mirror                                      b)  scale                                c)  donut                               d)  r
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otate 

 

 

181.           Autocad’ deki sivri köşeleri radüs atma komutu aşağıdakilerden hangisidir? 

a) edit 

text                                  b)  filet                                  c)  chamfer                          d)  circle 

  

182.         Dimension style menüsü autocad’de ne işe yarar ? 

a) Ölçülendirme yapılır                                 b) Ölçülendirme ayarı ve yeni ölçülendirme 

karakterleri Yaratılır 

c) Sadece ölçülendirme ayarı yapılır               d) Dimension menüsünü açmaya yarar 

  

183.           Çizilen şekilleri çizim alanında sağsola, yukarı-aşağı sürüklemeyi sağlayan 

komut hangisidir? 

a) move                                       b) 

ofset                                 c)  pan                                   d)  array 

  

184.           Çizilen tüm resimleri ekranda görmemi sağlayan zoom komutu klavyeden 

nasıl kullanılır? 

a) Zoom-dynamic                     b)  Zoom-v                           c)  Zoom-

A                          d)  Zoom- P 

  

185.           Çıktı alma komutu olan plot hangi araç kutusundadır ? 

a) standart toolbar                  b) properties tollbar            c)  draw 

tolbar                     d)  modify toolbar 

  

186.           Autocad’ de çizgileri birbirine uzatılmasını sağlayan komut aşağıdakilerden 

hangisidir ? 

a) extend                                    b)  break                               c)  break at 

point                d)  spline 

 

 

187.           Autocad’ de üçgen, beşgen gibi çokgenleri çizmemizi sağlayan komut 

aşağıdakilerden hangisidir? 

a) polyline                                   b)  polygon                          c)  multiline                          d)  

move 

  

188.Bir objenin bütün özelliklerini tanımlayan komut aşağıdakilerden hangisidir? 

a) match properties                   b) dimension 

style              c) properties                       d) insert 

  
189.           Autocad’ de çizilmiş bir şekli geri alarak eskiye dönmemi sağlayan komut 

aşağıdakilerden hangisidir? 

a) redo                                         b) 

plot                                   c) undo                                 d) öyle bir komut yok 
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190.         Perspektiflerden görünüş çıkarırken önce hangi görünüş çizilir? 

a) Ön                                            b) Üst                                    c) Yan                                   d) 

Arka 

  
191.         Gerçek ölçek'te, Ölçek ………………. diye belirtilir. 

a)  1:2                               b) 2:1                          c) l:1                           d) 1:4 

  

192.         Perspektiflerden görünüş çıkarırken  görünmeyen çevre ve kenarların 

çiziminde hangi çizgi kullanılır? 

a) Sürekli ince çizgi          b) Sürekli kalın çizgi   c) Kesik orta çizgi      d) Noktalı ince çizgi 

  

193.         Ölçülendirme yapılırken, ölçü çizgisi görünüşten  yaklaşık  ne  kadar uzaklıkta 

bulunmalıdır? 

a) l-3mm                           b) 7-10mm.                 c) 15-18mm.               d) 18-20mm. 

  

194.         Bir cismin bir düzlem üzerine  çizilmiş şekli, Bir cismin bir düzleme düşen 

görüntüsü. Güneşli bir günde yürürken yerde oluşan gölgemiz, Sinemada perdeye düşen 

görüntü, Yukarıdaki olaylarda elde edilen görüntülere ne denir'? 

a) Şekil                             b) Resim                     c) Perspektif                d) İzdüşüm 

  

195.         Aşağıdakilerden hangisi yaptığınız çizimin çıktısını almak için print ayarlarını 

gösteren diyalog sayfası adıdır'? 

a) Paper                            b) Plot                         c) Layout                    d) Setting 

  

196.         Aşağıdakilerden hangisi yaptığınız çizimlerin pencereye göre çıktı almanızı 

sağlayan seçenektir? 

a) Paıtial Previevv             b) Ful I Previevv         c) Window                  d) Plot Extents 

  

197.         Aşağıdakilerden hangisi yaptığınız çizimlerin çıktı almadan önce nasıl 

görüneceğini 

gösteren seçenektir? 

a) Partial Previevv            b) Full Previevv         c) Windovv                 d) Plot device 
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198.         Aşağıdakilerden hangisi yaptığınız çizimlerin boyutlarına bakmadan ekrana 

tam olarak  yayar ? 

a) Full                               b) Splay                      c) Limits                      d) Extents 

  

199.         Aşağıdakilerden hangisi kağıt üzerine aktarılacak çizimlerin ölçeğini gösteren 

seçenektir? 

a) Plot secale                   b) Change OScale       c) Properties                d) Extents 

  

200.         Aşağıdakilerden hangisi yazdırılacak doğru yazıcı seçeneğidir. 

a) Plot to file                     b) Plot Device             c) Properties                d) Page setup 

  

201.         Aşağıdakilerden hangisi ölçülendirme araç çubuğudur? 

a) Surfaces                                   b) Dimension              c) Object Snap            d) Modify 

  

202.           Aşağıdakilerden hangisi merkez işareti koymak için kullanılan komuttur? 

a) Dimcenter                              b) Dimcontinue                   c) Dimdiameter                   d) 

Dimradius 

203.           Aşağıdakilerden hangisi sürekli ölçülendirme yapan komuttur? 

a) Dimdiameter                          b) Dimcontinue                   c) Dimcenter                        d) 

Dimedit 

204.           Aşağıdakilerden hangisi ölçülendirme yazı menüsüne girmek için kullanılır? 

a) Lines and Aitows                   b) Primary Units                  c) Text                                  d) 

Tolerance 

205.           Aşağıdakilerden hangisi AutoCAD ekranına yazı eklemek için kullanılır? 

a) Text                                         b) Mtext                               c) Dimtext                            d) 

Textstyle 

206.           Aşağıdakilerden hangisi yazılara sembol eklemek için kullanılan komuttur? 

a) Textsymbol                            b) Align                                 c) Symbol                            d) 

Character 
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207.           Aşağıdakilerden hangisi daha önceden yazılmış yazının özelliklerini 

değiştirmek için kullanılır ? 

a) Dimtext                                   b) Text properties             c) Multiline Text Editör     d) 

Import Text 

  

208.         Antedi oluşturulmuş bir çizim kağıdı farklı kaydet(save as) seçeneği ile 

kaydedilerek nasıl bir fayda sağlanır? 

a) Antede daha doğru bilgiler yazılır.                           b) Görünüşler daha rahat çıkartılır.  

c) Her çizim için antet oluşturma gerekmez.               d) ÖIçülendirme rahat yapılır. 

  

209.           Aşağıdaki durumların hangisinde "array" komutunun kullanılması uygun 

olur? 

a) Bir çizimin simetrisinin oluşturulması,                              b) Bir objeyi belirli sayıda 

çoğaltma 
c) Bir çizgiyi budama.                                                              d) Bir bloğu çizime çoklu olarak 

ekleme. 

  

210.         Bir  objenin özelliklerini  başka bir objeye aktarmak için hangi komut 

kullanılır? 

a) Copy                                        b) ofset                                 c) trim                           d) 

matchprop 

  

211.         Tarama işlemi aşağıdaki komutlardan hangisi ile yapılır? 

a) Chamfer                                  b) ofset                          c) hatch                        d) trim 

  

212.           Çizimin bir bölgesini seçerek belirleyerek çıktı alma işlemi aşağıdakilerden 

hangisi ile gerçekleştirilir? 

a) Plot arca/ limits                      b) Plot area/window         c) Plot area/extents            d) Plot 

arca/ display 

  

213.           Yeni bir dosya açmak için hangi komut kullanılır? 

a) Open                                        b) New                                  c) Save                                  d) 

Plot 
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214.           Bir dosyayı değişik isimle kaydetmek için hangi komut kullanılır? 

a) Save as                                    b) Plot                                   c) Save                                  d) 

Exit 

  

215.         Programdan çıkmak için hangi komut kullanılır'? 

a) Close                                        b) Page sttıp                         c)    Exit                                d) 

Save 

  

216.           Line komutunun işlevi aşağıdakilerden hangisidir? 

a) Çizgi                                        b) Yay                                   c) Çember                            d) 

Çokgen 

217.            2 Boyutlu çizimde kullanılmayan eksen aşağıdakilerden hangisidir? 

a) WC                                           b) X                                       c) Y                                       d) 

Z 

  

  

218.  Çizimde 300 derece ile -60 derece aynımıdır? 

a) Hiçbir zaman                        b) Hayır                                               c) Bazı 

Durumlarda           d) Evet 

219.  Aşağıdakilerden hangisi Print komutunun çalıştırılması için kullanılamaz? 

a) Alt+P - Tuş kombinasyonu                                               b) Ctrl+P - Tuş kombinasyonu 

c) Komut satırından – Print                                                    d) Komut satırından – PLOT 

  

220.  Aşağıdakilerden hangisi Undo komutunun tuş kombinasyonudur? 

a) Alt+Z                                        b) Ctrl+U                              c) Ctrl+Z                              d) 

Alt+U 

  

221.  270 derecelik bir çizgi hangi yöne çizilir? 

a) Sola                                          b) Yukarı                             c) Aşağı                                d) 

Sağa 
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 222.  Çemberler kaç adet yakalama (snap) noktasına sahiptir? 

a) 5                                                               b) 2                                        c) 

3                                        d) 4 

  

223.   Aşağıdakilerden hangisi mavi kareler için kullanılan doğru terimdir? 

a) Grips                                         b) Mavi Kareler                   c) Grabbers                          d) 

Seçim İşareti 

  

224.  Aşağıdakilerden hangisi kayıt etme komutudur? 

a) Alt+s                                        b) Ctrl+a                               c) Ctrl+s                               d) 

Alt+v 

  

225.  Aşağıdakilerden hangisi ekrandaki tüm çizimleri seçme komutudur? 

a) Alt+a                                        b) Ctrl+a                              c) Ctrl+v                               d) 

Alt+c 

  

226.  Aşağıdakilerden hangisi tarama komutun kısa yazılışıdır? 

a) h                                                               b) b                                        c) 

e                                         d) f 

  

227.  Aşağıdakilerden hangisi silme komutun kısa yazılışıdır? 

a ) c                                               b) b                                        c) 

e                                         d)f 

  

228.  Aşağıdakilerden hangisi tr kısa yazılışın tamamıdır? 

a) copy                                         b)erase                                  c) trim                                  d) 

filet 

  

229.  Aşağıdakilerden hangisi properties komutun kısa yazılışırdır? 

a) Pr                                             b) Pe                                      c) Po                                      d) 

Ps 
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230.  divede ne demektir? 

a) parçala                                    b) sil                                       c) böl                                     d) 

ayarla 

  

231.  measure ne demektir? 

a) yardım                                    b) ölç                                     c) böl                                     d) 

taşı 

  

232.  Point ne demektir? 

a) nokta                                       b) virgül                                c) copyalama                      d) 

pencere 

  

233.  plot ne demektir? 

a ) nokta                                      b) virgül                                 c) çizdirmek                         d) 

ekran 

  

234. Aşağıdakilerden hangisi yaptığınız çalışmayı kaydetmek için kullanılan komuttur? 

a) File                                          b) Save                                 c) Trim                                  d) 

Move 

235.Aşağıdakilerden hangisi çizgi çizmek için kullanılan komuttur? 

a) Save as                                  b) Rectangle                        c) 

Hatch                                               d) line 

  

236. Aşağıdakilerden hangisi yay çizmek için kullanılan komuttur? 

a) Mirror                                     b) Grid                                   c) Arc                                    d) 

Trim 

  

237. Aşağıdakilerden hangisi standart araç çubuğunda bulunmaz? 

a) format                                    b) tools                                  c) dimension                        d) 

advance setup 

 

 

 

238-Render’da gölge oluşturabilmek için aşağıdakilerden hangisi kullanılmalıdır? 
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a)Material b)Light c)Background  d)Fog 

 

239-AutoCad’te kağıda çıktı almak için hangi komut kullanılır? 

a)Plot  b)Preview c)Publish  d)Layout 

 

240 )Toolbar’lar aşağıdakilerden hangisi ile açılabilir? 

a)View-Toolbars 

b)View-Display 

c)View-Zoom 

d)View-Regen 

241-Aşağıdaki shade modlarından hangisi cismi gölgelendirilmiş dolu obje olarak 

gösterir? 

a)2D wireframe b)3D wireframe c)Hidden d)Flat Shaded 

 

242-Aşağıdaki zoom’lardan hangisi eşzamanlı büyültme-küçültme yapar? 

a)Pan  b)Realtime  c)Previous  d)Window 

 

243-Tolerans simgesi hangi konu ile ilgilidir? 

a)Design Center b)Insert c)Dimension  d)Editing 

 

244-Alan,hacim ve koordinat bilgilerini veren komutlar hangi toolbar içinde bulunur? 

a)Dimension  b)Shade c)Modify  d)Inquiry 

 

245-Aşağıdaki komutlardan hangisini kullanarak, seçili iki boyutlu cismi belli bir yönde 

sündürebiliriz? 

a)Scale  b)Stretch c)Extend d)Measure 

 

246-Chamfer komutunun görevi nedir? 

a)İki çizgi yuvarlatılarak birleştirilir 
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b)Objelerin boyutunu büyütüp,küçültür 

c)Köşelerden pah kırma işlemini yapar 

d)Objeleri döndürmek için kullanılır 

 

247-Aşağıdaki komutlardan hangisi Lengthen komutunda çizgi uzatma yöntemlerinden 

biri değildir? 

a)Delta  b)Dynamic c)Percent d)Extend 

 

248-İstenilen objeyi (çizgi,yay vb.) belirlediğimiz sayıda nokta veya blok kullanarak eşit 

aralıklarla işaretlemeyi sağlayan komut aşağıdakilerden hangisidir? 

a)Divide b)Measure c)Array d)Hepsi 

 

249-Ölçülendirmede yazının altında kalan çizgiye ne ad verilir? 

a)Dimension Line b)Extension Line c)Baseline d)Leader 

250-Ölçülendirmedeki ok başlarına ne ad verilir? 

a)Leader b)Arrow Head  c)Mark  d)Fit 

 

251-Boundary komutunun kısayolu nedir? 

a)bo  b)b  c)ob  d)bou 

 

252-Alan ölçme komutu olan Area’nın kısayolu nedir? 

a)aa  b)ar  c)a  d)are 

 

253-Komut iptali yapan kısayol tuşu hangisidir? 

a)Mouse sağ tuş b)Space c)Esc d)Tab 

 

254-Belirlenen açılarda imlecin takılarak çizim yapmasını sağlayan komut (koordinat 

sistemi) hangisidir? 

a)Orthogonal  b)Polar  c)İzometrik d)Layout 
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255-Oran belirterek büyütüp,küçültme yapabildiğimiz zoom hangisidir? 

a)Pan  b)Window  c)Scale  d)Extent 

256-Merkezle büyüklüğü kontrol edilebilen bir dörtgenle yaklaşma yapabilen zoom 

hangisidir? 

a)Extent            b)Window  c)Dynamic d)Center 

 

257-Aşağıdakilerden hangisi 3D...........boşluğuna koyularak bir komut oluşturmaz? 

a)Mirror  b)Array  c)Rotate  d)Stretch 

 

258-Aşağıdakilerden hangisi Osnap Setting’de mevcuttur? 

a)Vertex          b)Perpendicular     c)Pivot       d)Face 

 

259-Hangisiyle bir merkez etrafında kopyalama yapılır? 

a)Copy      b)3D Array      c)Array      d)Align 

 

260-Ölçülendirmede  hedef noktaya doğru uzanan çizgilerin adı nedir? 

a)Extension Line   b)Arrow Head      c)Quick Leader    d)Extend Beyond 

 

261-Aşağıdakilerden hangisi block çağırma metodu değildir? 

a)Insert       b)Desing Center   c)Tool Paletes    d)Mirror 

 

262-Aşağıdakilerden hangisi AutoCad’in çıkış verdiği dosya formatlarından  değildir? 

a).dwg         b).dxf    c).jpeg      d).avi 

 

263-Bir çizim nesnesinin özelliklerini başka bir çizim nesnesine kopyalayan komut 

hangisidir? 

a)Change     b)Match Proparties       c)Quick  Select       d)Design Center 
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264-Aşağıdakilerden hangisi nesne özellikleri ile ilgili bir komut değildir? 

a) Change     b)Match Proparties       c)Proparties        d)Arc 

 

265-“Edge” in karşılığı nedir? 

a)Kesmek     b)Seçmek      c)Kenar      d)Nesne 

 

266-“Boundary” in karşılığı nedir? 

a)Sınır      b)Uzatmak     c)Budamak     d)Patlatmak 

 

 

267-Herhangi bir resmi çizim alanına nasıl getiririz? 

a)Insert      b)Copy      c)Raster İmage      d)Block 

 

 

268-Herhangi kapalı bir alanı hangi komutla tararız? 

a)Extrude        b)Hatch            c)Region       d)Wipeout 

 

 

269-Katı modellemede Fillet komutunda, zincir şeklinde teğetsel çizgileri aynı anda 

hangi seçenekle yapabiliriz? 

a)Chain     b)Shift       c)Edge        d)Radius 

 

270-Hangi iki komut birbirine shift tuşuyla geçiş yapabilir? 

a)Trim / Extend      b)Copy / Move       c)Trim / Stretch       d)Trim / Scale 

 

271-Layer’de hangisi yoktur? 

a)Render     b)Kilitleme     c)Çizgi kalınlığı   d)Çizgi tipi 

272- Multi-line komutu ile 4 adet paralel çizgiyi aynı anda çizmek için aşağıdakilerden 

hangisi ile bir düzenleme yapılır? 
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a) Multiple Point 

b) Multi-line style 

c) Text Style 

d) Help 

273-AutoCAD'de stiller ve biçimler oluşturmayı ve yönetmeyi sağlayan komutlar hangi 

menü altında toplanmıştır? 

 

a) Draw 

b) Dimension 

c) File 

d) Format 

 

274- AutoCAD'e dair aşağıdakilerden hangisi doğrudur? 

 

a) AutoCAD ile çizim dosyalarının içine müzik eklemek mümkündür. 

b) AutoCAD resim dosyalarına rötuş ve montaj programıdır. 

c) AutoCAD vektörel bir çizim programıdır. 

d) AutoCAD film dosyaları üzerinde oynamalar yapar. 

 

275- Fence'e dair aşağıdakilerden hangisi doğrudur? 

 

a) Bir obje seçim aracıdır. 

b) Çizim komutudur. 

c) Hiç bir komutun içinde değilken de çalışır. 

d) Ölçülendirme aracıdır. 
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276- View > Render > Fog komutu aşağıdakilerden hangisini yapar? 

 

a) Sahneyi görselleştirir. 

b) Sahne görselleştirmesine sis efekti ekler. 

c) Sahnedeki çizimlere malzeme ataması yapar. 

d) Sahne aydınlatması yapar. 

 

277- Redo komutu aşağıdakilerden hangisini yapar? 

 

a) Son geri alınan işlemi tekrar ileri alır. 

b) Geri alma işlemi yapar. 

c) Kopyalama işlemi yapar. 

d) Sahne görüntüsünü yana kaydırır. 

 

278-Trim komutu aşağıdakilerden hangisine uygulanamaz? 

a)Line     b)Arc        c)Pline         d)Face  

 

279-Extend komutu ne yapar? 

a)Uzatma       b)Budama        c)Silme      d)Yükseltme 

 

300-Bir cismin simetrisini almak için hangi komut uygulanır? 

a)Copy         b)Mirror        c)Move       d)Blok 

 

301-Yeni bir cisim oluşturan üretim komutları hangi menü altındadır? 

a)Tools       b)Draw      c)Modify      d)Format 
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302-Düzenleme komutları hangi menüdedir? 

a)View        b)Tools        c)Format       d)Modify 

 

303-Autocad’de dosya seçim kullanıcı tercihleri gibi seçeneklerin ayarlandığı komut 

hangisidir? 

a)Chage       b)Proporties     c)Option     d)İnsert  

 

304-Circle komutunun kısa yolu hangisidir? 

a)c        b)co         c)ci         d)Cr 

 

305-Aşağıdakilerden hangisi (enter)’in yerini görmez? 

a)Sol tuş     b)Sağ tuş      c)Space bar     d)Hiçbiri 

 

306-Hangisi hepsi anlamına gelir? 

a)Select      b)None    c)Object      d)All 

 

307-Hangisi açı anlamına gelir? 

a)Scale    b)Rotate     c)Base        d)Angle 

 

308-“Edge” in karşılığı nedir? 

a)Kesmek     b)Seçmek      c)Kenar      d)Nesne 

 

309-“Boundary” in karşılığı nedir? 

a)Sınır      b)Uzatmak     c)Budamak     d)Patlatmak 

 

310-Hangisiyle bir merkez etrafında dairesel kopyalama yapılır? 
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a)Copy      b)Move     c)Array      d)Align 

AutoCAD2007 Test Soruları 

 

311. Aşağıdaki komutlardan hangisi daire, yay, elips, elips yayın ve spline çizgilerinin 

bozulmuş, köşeli göründüğü durumlarda görüntüyü eski haline getirmek için kullanılır? 

a) Regen 

b) Purge 

c) Limits 

d) Units 

 

312. AutoCAD’te ışıklandırma işlemleri hangi araç çubuğu üzerin gerçekleştirilir? 

a) Render 

b) Web 

c) Lights 

d) Visual Styles 

 

313. Aşağıdaki komutlardan hangisi hem iki hem üç boyutlu çizimler üzerinde 

kullanılabilir? 

a) Rotate 

b) Extrude Faces 

c) Subtract 

d) Box 

 

314. Seçilen objeleri belirli bir referans noktasına göre, istenilen açıda döndürülmesini 

sağlayan komut aşağıdakilerden hangisidir? 

a) Move 

b) Rotate 

c) İnsert Block 

d) Align 

 

315. Üç boyutlu çizimlerde arkada kalan bölümlerin görünmemesi için kullanılan komut 

hangisidir? 

a) 2D Wireframe 

b) LWT 

c) UCS 

d) 3D Hidden 

 

316. Çizgi tipi ayarlarının yapılmasında kullanılan komut hangisidir? 
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a) Text 

b) Type 

c) Linetype 

d) Line 

 

317. İki yada daha fazla katı modeli birleştirmek amacıyla kullanılan Solids Editing 

menüsü komutu hangisidir? 

a) Union 

b) Pedit 

c) Align 

d) Presspull 

318.  Yandaki komut için aşağıdakilerden hangisi söylenemez? 

a) İki boyutlu çizimlerde kullanılabilir 

b) Üç boyutlu katı objelerde kullanılabilir 

c) Köşe yuvarlatmak amacıyla kullanılır 

d) 3 boyutlu katı objelerde kesinlikle kullanılamaz 

 

 

319. Aşağıdakilerden hangisi Print komutunun çalıştırılması için kullanılamaz? 

a) Alt+Z - Tuş kombinasyonu 

b) Ctrl+P - Tuş kombinasyonu 

c) Komut satırından – Print 

d) Komut satırından – Plot 

 

320. Aşağıdakilerden hangisi ekrandaki tüm çizimleri seçmeye yarayan tuş 

kombinasyonudur? 

a)  Alt+A 

b) Ctrl+A 

c) Ctrl+V 

d) Alt+C 

 

321. Point ne demektir? 

a) Nokta 

b) Kesişim 

c) Köşe 

d) Daire 
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322. AutoCAD içerisinde yer alan CAD hangi anlama gelmektedir? 

a) Bilgisayar destekli tablo oluşturma programı 

b) Bilgisayar destekli statik çizimi 

c) Bilgisayar destekli üretim 

d) Bilgisayar destekli tasarım 

 

323. Aşağıdakilerden hangisi araç çubukları için söylenemez? 

a) Ekranda yüzer halde bulunabilirler 

b) İstenildiğinde kapatılabilirler 

c) Yerleri her zaman aynıdır ve değiştirilemezler 

d) Herhangi bir araç çubuğuna fare ile sağ tıklanarak kapalı çubuklar açılabilirler 

 

324.   Soldaki resimde görünen komut simgeleri hangi araç 

çubuğunda yer alırlar? 

a) Solid Editing 

b) Render 

c) Modify 

d) Draw 

 

325. Export komutu hangi amaçla kullanılır? 

a) Başka programlardan çizim almak için 

b) Çizgileri uzatmak için 

c) “Z” ekseninde katılık vererek üç boyutlu nesne oluşturmak için 

d) Başka programlara ait dosya formatları oluşturmak için 

 

326. Quick Select komutu ne işe yarar? 

a) Farklı çizgilerin ortak bir özelliğini kullanarak hepsini bir seferde seçmek için 

b) Hızlı ölçülendirme yapmak için 

c) Hızlı silindirler çizmek için 

d) Line ve arclardan oluşan çizgileri polyline hale getirmek için 

 

327. Aşağıdakilerden hangisi Ctrl+X tuş kombinasyonunun yaptığı görevi yerine getirir? 

a)  

b)  
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c)  

d)  

 

328. Aşağıdakilerden hangisi yanlıştır? 

a) Limits - Çizilen objelerin boyutlarını değiştirir 

b) Divide - Bir doğru ya da yayı istenilen sayıda eşit parçalara böler 

c) Scale - Seçilen nesneleri, bir noktanın etrafında büyütüp-küçültür 

d) Redo - Geri alınarak iptal edilen işlemleri ileri alarak yeniler 

 

329. AutoCAD ilk defa açıldığında çizim alanı ne renktedir? 

a) Beyaz 

b) Mavi 

c) Siyah 

d) Kırmızı 

 

330. Klavyedeki Boşluk tuşunun görevi değildir? 

a) Enter görevi görür 

b) Klavyeden kısa yolu yazılan komutu aktifleştirir 

c) Osnap durumunu açar 

d) Son girilen komutu tekrar eder 

 

331. Klavyede yer alan virgül (,) tuşu hangi amaçla kullanılır? 

a) Ondalık sayı ayracı olarak kullanılır 

b) Spline komutunun kısa yoludur 

c) Polygon komutunda köşegen sayısını değiştirir 

d) X,Y,Z eksenlerine ait noktaları tanımlarken, eksen ayracı olarak kullanılır 

 

332. Klavyede yer alan nokta (.) tuşu hangi amaçla kullanılır? 

a) Ondalık sayı ayracı olarak kullanılır 

b) Spline komutunun kısa yoludur 

c) Polygon komutunda köşegen sayısını değiştirir 

d) X,Y,Z eksenlerine ait noktaları tanımlarken, eksen ayracı olarak kullanılır 

 

333. Klavyede bulunan küçüktür (<) tuşu hangi amaçla kullanılır? 

a) Uzunluğu küçültülmek istenilen çizgilerin ne kadar kısaltılacağını girmeden önce basılır 
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b) Z ekseninde fazla yüksek olan cisimleri kısaltırken yazılan değerin önüne koyulur 

c) Çizgiye açısal değer verip çizgi yönünü sabitlemek için açı değerinin önünde kullanılır 

d) Bir çizginin diğerine göre küçük çizilmesini sağlar 

 

334. Aşağıdakilerden hangi çizimde katman kullanmanın avantajlarından değildir? 

a) Karmaşık çizimlerde bazı çizgileri gizleyerek çizim kolaylığı sağlaması 

b) Kullanılmayan çizgileri otomatik olarak silmesi 

c) Katmana tanımlanan kalınlığı, o katmandaki bütün çizgilere uygulaması 

d) Katmanın kilitlenerek, o katmana ait bütün çizgilerde işlem yapılmasını engellemesi 

 

335. Aşağıdaki komut simgelerinden hangisi bir çizginin bütün özelliklerini başka bir 

çizgiye taşımak amacıyla kullanılır? 

a)  

b)  

c)  

d)  

 

336. Farede mevcut orta tekerleğin döndürülmesi hangi görevi yerine getirir? 

a) Klavyedeki Enter tuşu görevi görür 

b) Oluşturulan çizginin uzunluğunun ayarlanması için kullanılır 

c) Çizime Z ekseninde katılık verilirken, katılığın açısını ayarlar 

d) Çizimin belirli bölgelerini büyütüp küçültmeye yarar 

 

337. Klavyede bulunan ESC tuşunun görevi nedir? 

a) Osnap durumunu kapatır/açar 

b) Polar durumunu kapatır, Orto durumunu açar 

c) Komuttan işlem yapmadan çıkmayı sağlar 

d) Trim ve Extend komutları arasında geçişi sağlar 

 

338.  Yandaki komutlar hangi diyalog penceresinde yer 

alırlar? 

a) Materials 

b) Draw 

c) Modify 

d) Dimension 
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339. Plot dialog kutusundan aşağıdaki formatlardan hangisi ile çıktı alınmaz? 

a) PDF 

b) JPG 

c) PNG 

d) AVI 

 

340. Aşağıdakilerden hangisi araç çubuğu değildir? 

a) Web 

b) Point Style 

c) Draw Order 

d) Standart 

 

341. Hatch komutu ile ilgili olarak aşağıdakilerden hangisi söylenemez? 

a) Yapılan taramaların açıları değiştirilebilir 

b) Yapılan taramalar kopyalanabilir 

c) Tarama yapılacak alanın kesinlikle kapalı olması gerekmez 

d) Tarama yapılacak alanın mutlaka kapalı olması gerekir 

 

342. Aşağıdakilerden hangisi AutoCAD içerisinde çap işareti olarak kullanılır? 

a) Ø 

b) @ 

c) € 

d) $ 

 

343. Aşağıdakilerden hangisi AutoCAD ilk açıldığında ekranda bulunmaz? 

a) Çekme menüler 

b) Araç çubukları 

c) Komut satırı 

d) Dimension Style Manager 

 

344. Draw çekme menüsü içinde “Circle” alt komutlarından biri olan, belirlenen 3 noktadan 

teğet geçecek şekilde daire çizmeyi sağlayan komut aşağıdakilerden hangisidir? 

a) Tan, Tan, Tan 

b) Center, Diameter 

c) Tan, Tan, Radius 

d) 3 Points 
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345. Bir objenin bütün özelliklerini tanımlayan komut aşağıdakilerden hangisidir? 

a) Match Properties 

b) Dimension Style 

c) Properties 

d) Insert 

 

346. Koruma gerektiren bir çizim dosyasına aşağıdaki pencerelerden hangisinde şifre 

koyabiliriz? 

a) Point Style 

b) Save As 

c) Print 

d) Units 

 

347. Aşağıdakilerden hangisi ile seçili çizgi silinemez? 

a) Klavyeden DEL tuşu 

b) Modify araç çubuğundan   simgesi 

c) Klavyeden E tuşuna basıp Enter tuşuna basmak 

d) Klavyeden Shift tuşu 

 

348. Aşağıdakilerden hangisi ile seçilen çizgi kopyalanamaz? 

a) Ctrl+C tuş kombinasyonu 

b) Alt+C tuş kombinasyonu 

c) Klavyeden CO yazıp Enter tuşuna basmak 

d) Modify araç çubuğundan  simgesi 

 

349. Aşağıdaki komutlardan hangisiyle alan hesabı yapmak mümkündür? 

a)  

b)  

c)  

d)  
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350. Aşağıdaki komutlardan hangisi üç boyutlu çizimlerde SİS efekti vermek için 

kullanılabilir? 

a)  

b)  

c)  

d)  

 

351. Aşağıdaki komutlardan hangisi Zoom araç çubuğunda yer alamaz? 

a)  

b)  

c)  

d)  
352. Aşağıdaki komutlardan hangisi 3 boyutlu spiral çizmek için kullanılır? 

a)  

b)  

c)  

d)  

 

353. Aşağıdakilerden hangisi Loft komutunun simgesidir? 

a)  

b)  

c)  

d)  

 

354. Aşağıdakilerden hangisi polyline ve region olmayan çizgilere katılık verirken 

kullanılabilir? 
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a)  

b)  

c)  

d)  

 

 

355. Aşağıdakilerden hangisi Light List komutuna ait simgedir? 

a)  

b)  

c)  

d)  

 

356. Aşağıdakilerden hangisi üç boyutlu katıları, yüzeyler (Face) haline, yüzeylere 

uygulandığı zaman ise çizgiler haline getiren komuttur? 

a)  

b)  

c)  

d)  

 

357. Aşağıdakilerden hangisi 3D Move komutunun simgesidir? 

a)  

b)  

c)  

d)  
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358. Yanda simgesi görünen komutun adı nedir? 

a) 3D Align 

b) Copy 

c) Offset 

d) Imprint 

 

359.   Yandaki simgesi görülen komutun adı nedir? 

a) Polyline 

b) Multiline 

c) Polysolid 

d) Mline 

360. Aşağıdakilerden hangisi yapılan çizimin çıktısını almak için yazıcı ayarlarını gösteren 

diyalog sayfası adıdır? 

A) Paper      

B) Plot 

C) Layout      

D) Setting 

 

361. Aşağıdakilerden hangisi kağıt tipi seçmeye yarar? 

a-) Paper size 

b-) Plot device      

c-) inches      

d-) mm 

 

362. Aşağıdakilerden hangisi yaptığınız çizimleri oluşturduğunuz pencereye göre çıktı 

almanızı sağlayan seçenektir? 

a-) Paper Size      

b-) Plotter      

c-) Window 

d-) Plot Extents 

 

363. Aşağıdakilerden hangisi yaptığınız çizimlerin çıktı almadan önce nasıl görüneceğini 

gösteren seçenektir? 

a-) Baskı Önizleme      

b-) Preview 

c-) Window      

d-) Plot device 
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364. Aşağıdakilerden hangisi yaptığınız çizimlerin tamamını ekrana sığdırır? 

a-) Display      

b-) Limits      

c-) Window      

d-) Extents 

 

365. Aşağıdakilerden hangisi kâğıt üzerine aktarılacak çizimlerin ölçeğini gösteren 

seçenektir? 

a-) Plot scale 

b-) Change      

c-) Scale       

d-) Properties 

 

366. Aşağıdakilerden hangisi plot penceresini açar? 

a-) Plot to file      

b-) Plot Device       

c-) Properties      

d-) Ctrl+P 

 

367. Aşağıdakilerden hangisi çizdiğiniz resmin çıktısını alırken kâğıt konumunu belirleyen 

diyalog sayfası adıdır? 

a-) Plot to file      

b-) Plot Device        

c-) Properties            

d-) Drawing orientation 

 

368. Aşağıdakilerden hangisi çizdiğiniz resmin çıktısını kâğıda 180º döndürerek 

yerleştirme işlemini yapmak için kullanılan seçenektir? 

a-) Potrait      

b-) Landscape      

c-) Plot upside-down 

d-) Display 

 

369. Aşağıdakilerden hangisi izometrik çizimi başlatmak için kullanılan diyalog sayfasıdır? 

a-) Drafting Settings 

b-) Layers      

c-) Block Definition      

d-) Dimension Style 

 

370. Aşağıdakilerden hangisi çizim alanında yeni katmanlar oluşturan komuttur? 
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a-) Hatch      

b-) Layer 

c-) Toolbar      

d-) Move 

 

371. Aşağıdakilerden hangisi Layer Properties’de değiştirilemez? 

a-) Renk       

b-) Çizgi tipi      

c-) Katman adı      

d-)  Ölçek 

 

372. Aşağıdakilerden hangisi “Katman” ikonudur? 

a-)  

b-)  

c-)  

d-)  
 

373. Aşağıdakilerden hangisi katmanın açık olduğunu ifade eder? 

a-)  

b-)  

c-)  

d-)  
 

374. Aşağıdakilerden hangisi “Tarama” ikonudur? 

a-)  

b-)  

c-)  

d-)  
 

375. Aşağıdakilerden hangisi “Tarama” (Hatch and Gradient) diyalog sayfasında 

bulunmaz? 

a-) Angle       

b-) Type       
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c-) Pattern       

d-) Revision Cloud 

 

376. Hangi komut bir nesneyi dizi halinde kopyalamak için kullanılır? 

a-) Copy       

b-) Array        

c-) Multiple       

d-) Multiline 

 

377. Aşağıdaki komutlardan hangisi birbirine paralel çizgiler çizmek için kullanılır? 

a-) 2Line        

b-) Xline        

c-) Line        

d-) Multiline 

 

378. Aşağıdakilerden hangisi “Taşıma” ikonudur? 

a-)  

b-)  

c-)  

d-)  
 

379. Aşağıdakilerden hangisi “Polygon” komutunun kullanım amacıdır? 

a-) Çokgenler çizmek 

b-) İstenilen sayıda nokta çizmek 

c-) İç içe daireler çizmek                  

d-) Birbirine 45º doğrular çizmek 

 

380. Aşağıdakilerden hangisi nokta şeklini değiştirmek için kullanılan yoldur? 

a-) Format → Text Style     

b-) Format → Point Style      

c-) Regen      

A) View→3D Views 

 

381. 22. Aşağıdakilerden hangisi yüzey modelleme için kullanılan bir komut sembolüdür? 

a-)  

b-)  
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c-)  

d-)  
 

382. Aşağıdakilerden hangisi “Elev” komutunun kullanım amaçlarındandır? 

a-) Çizgiye açı vermek                  

b-) Çizgiye renk vermek       

c-) Çizgiyi silmek                          

d-) Çizgiye yükseklik vermek 

 

383. Aşağıdakilerden hangisi üç boyutlu yüzey oluşturmak için kullanılan komuttur? 

a-) Face      

b-) 3D Face      

c-) 3D Rotate      

d-) Color Faces 

 

384. Üç boyutlu çizimlerde, katı nesnenin arkasında kalan çizgileri saklayan komut 

sembolü hangisidir? 

a-)  

b-)  

c-)  

d-)  
 

385. Aşağıdakilerden hangisi üç boyutlu ortamda birleşik çoklu çizgi çizmek için 

kullanılır? 

a-) 3D Polyline      

b-) 3D Line      

c-) Polyline      

d-) 3D First Line 

 

386. Aşağıdakilerden hangisi üç boyutlu katı modeli iki parçaya böler? 

a-) 3D Polyline      

b-) imprint      

c-) Slice      

d-) Box3d 
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387. Aşağıdakilerden hangisi iki boyutlu kapalı ve polyline çizime üçüncü boyut vermek 

için kullanılır? 

a-) Align      

b-) Elev      

c-) Extrude      

d-) Subtract 

 

388. Aşağıdakilerden hangisi çoklu kopyalama yapar? 

a-)  

b-)  

c-)  

d-)  
 

389. Çizilen çizimi genişletmek ve daraltmak için hangisi kullanılır? 

a-)  

b-)  

c-)  

d-)  
 

390. Yazı tipi düzenlemesini yapmak için hangi yol kullanılır? 

a-) Format → Multiline Style      

b-) Format → Point Style 

c-) Format → Text Style              

d-) Format → Dimesion Style 

 

391. Aşağıdakilerden hangisi çizgi kopyalama işlemi yapamaz? 

a-)  

b-)  

c-)  

d-)  
 

392. Dörtgen çizmek için ….......... araç çubuğundan ….......... seçilir. 
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a-) Dimesion – Center      

b-) Modify – offset      

c-) Draw – Polygon      

d-) Draw – Rectangle 

 

393.  Yandaki düğmenin adı nadir? 

a-) Insert Block      

b-) Make Block      

c-) Group Block      

d-) Array 

 

394.  Yandaki düğmenin görevi nedir? 

a-) Son noktayı yakalar.                               

b-) Osnap durumunu kapatır / açar. 

c-) Osnap ayarları penceresini getirir.          

d-) Snap durumunu kapatır / açar. 

395. Osnap durumu klavyeden hangi düğmeyle on / off olur? 

a-) F1      

b-) F2      

c-) F5      

d-) F3 

 

396. Grid durumu klavyeden hangi düğmeyle on / off olur? 

a-) F6       

b-) F4      

c-) F8      

d-) F7 

 

 

397. Düğmesi ne işe yarar? 

a-) Çizim açılarını gösterir.             

b-) Çizgi renklerini gösterir. 

c-) Çizgi kalınlıklarını gösterir.       

d-) Çizgi layerlarını gösterir. 

 

398. Aşağıdaki klavye kısa yollarından hangisi yeni katman açmak için kullanılır? 

a-) LA      

LWT 
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b-) NL      

c-) LPM      

d-) YK 

399. Layer seçeneklerinden  düğmesinin görevi nedir? 

a-) Layer’ı kilitli hale getirir.      

b-) Layer’ı görünmez yapar. 

c-) Layer’ı görünür yapar.           

d-) Layerla çizilen çizgileri beyaz yapar. 

 

400. İki boyutlu, parçalı ve kapalı çizgileri bir bütün haline getirip “yüzey”(Face) oluşturan 

komut ikonu aşağıdakilerden hangisidir? 

a-)  

b-)  

c-)  

d-)  
 

401. Aşağıdaki komutlardan hangisi bloğu elemanlarına ayırır? 

a-) Region      

b-) Extend      

c-) Break      

d-) Explode 

 

402. Hangisi çizilen çizginin x,y eksenleri yönündeki uzunluğunu komut satırında 

gösterir? 

a-)  

b-)  

c-)  

d-)  
 

403. Aşağıdakilerden hangisi seçilen çizgilerin yada üç boyutlu katıların 2 kat büyümesini 

sağlar? 

a-)  

b-)  
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c-)  

d-)  
 

404. Aşağıdakilerden hangisi “teğet nokta” yakalamakta kullanılır? 

a-)  

b-)  

c-)  

d-)  
 

405. Aşağıdakilerden hangisi “Draw” menüsünün ögelerindendir? 

a-) Erase      

b-) Mirror      

c-) Spline      

d-) Trim 

 

406. Hangisi çizimi siler? 

a-)  

b-)  

c-)  

d-)  

407. Aşağıdakilerden hangisi açı ölçmeyi sağlar? 

a-)  

b-)  

c-)  

d-)  
 

408. Aşağıdakilerden hangisi ölçme komutlarından değildir? 

a-) Linear      

b-) Angular     

c-) Baseline      

d-) Chamfer 
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409. Aşağıdakilerden hangisi yapılan işlemi geri alır? 

a-) Klavyeden M tuşu      

b-) Klavyeden R tuşu      

c-) Klavyeden U tuşu       

d-) Klavyeden G tuşu 

 

410. Snap durumunu…….. tuşuna basarak açıp kapatabiliriz. 

a-) F8      

b-) F7      

c-) F10     

d-) F9 

 

411. Aşağıdaki komutlardan hangisi ile çizgi ikiye bölünebilir? 

a-)  

b-)  

c-)  

d-)  
 

412. Çizim alanını aşağıdakilerden hangisi ile belirleriz? 

a-) Limits      

b-) Circle      

c-) Line      

d-) Fillet 

 

413.             Yandaki şeklin köşelerini                   hangi komutla yapabiliriz?     

a-) Fillet      

b-) Chamfer      

c-) Offset      

d-) Point 

 

414. Aşağıdakilerden hangisi çizginin orta noktasını yakalamak için kullanılır? 

a-)  

b-)  

c-)  
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d-)  
 

415. Çizilen çizimleri seçmek için aşağıdakilerden hangisi kullanılır? 

a-) Fare sağ tuşu      

b-) Shift tuşu basılı tutulur.     

c-) Fare sol tuşu 

d-) Yön tuşları 

 

416. Ekranı kaydırmak için kullanılan komut hangisidir. 

a-)  

b-)  

c-)  

d-)  
 

417. Yazıları ayrı ayrı yazmak için aşağıdaki yollardan hangisi izlenmelidir? 

a-) Modifiy Menüsü – Offset                                      

b-) Tools Menüsünden – Options 

c-) Draw Menüsünden – Text – Single Line Text      

d-) Draw Menüsünden – Arc – Start – Center – End 

 

418. Aşağıdakilerden hangisi “Properties” diyalog sayfasını açar? 

a-)  

b-)  

c-)  

d-)  
 

419. Aşağıdakilerden hangisi açıklama oku ve yazısı eklemeye yarayan “Ölçülendirme” 

(Dimension) komutudur? 

a-) Center mark      

b-) Quick Leader      

c-) Radius      

d-) Aligned 
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420. Hangisi hızlı ölçülendirme (Quick Dimension) komutudur? 

a-)  

b-)  

c-)  

d-)  
 

421. Daha önce alınmış bir ölçüden başlayarak, bundan sonra tıklanan noktaların ara 

mesafelerinin ölçülendirilmesini ………. komutu sağlar. 

a-) Tolerans      

b-) Leader      

c-) Baseline      

d-) Continune 

 

422. Aşağıdakilerden hangisi görüntüyü küçültür? 

a-)  

b-)  

c-)  

d-)  
 

423. Aşağıdakilerden hangisi çizimin tamamının ekranda görünmesini sağlar? 

a-)  

b-)  

c-)  

d-)  
 

424. Aşağıdakilerden hangisi seçilen noktanın X ya da Y ekseninde orjine olan uzaklığını 

verir verir? 

a-)  

b-)  
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c-)  

d-)  
 

425. Ölçülendirme yazılarının değişikliğini aşağıdakilerden hangisi ile yapabiliriz? 

a-) Edit Text      

b-) Dimesion Ordinate      

c-) Dimesion leader      

d-) Aligned 

 

 

 

 

426. Aşağıdakilerden hangisi “Render” komutunun kısa yoludur? 

a-) RO      

b-) RE      

c-) PL       

d-) RR 

 

 

 

 

 

427.   Yandaki şeklin görevi nedir? 

a-) Üçgen çizer      

b-) Dörtgen çizer      

c-) Katı çizimi tel kafes görünüm moduna getirir     

d-) Çokgen çizer 

 

 

 

 

428. Aşağıdakilerden hangisi ile “koni” çizebiliriz? 
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a-)  

b-)  

c-)  

d-)  
 

429.  Yandaki düğmenin görevi aşağıdakilerden hangisidir? 

a-) Gün ışığı ayarlarını yapmaya yarar             

b-) Katıları kendi ekseninde durmaksızın döndürür 

c-) Görünümünü değiştirir                                 

d-) Görüntüyü büyük ve küçük yapmayı sağlar. 

 

430. Aşağıdakilerden hangisi çizime Spot Işık ekler? 

a-)  

b-)  

c-)  

d-)  
 

431. Eklenen ışıkların ayarlarını hangisi ile değiştirebiliriz? 

a-)  

b-)  

c-)  

d-)  
 

432. Ölçülendirme ayarları hangi pencerede yapılır? 

a-) Layer Properties Manager      

b-) Lights in Model      

c-) Dimension Style Manager      

d-) Plot-Model 
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433. Circle komutu ile daire çiziminde çap girmek için hangi komut seçilir? 

a-) Radius      

b-) Diameter      

c-) Angle      

d-) Chamfer 

 

434.  Yandaki komutun görevi nedir? 

a-) Paralel çizgi çizer          

b-) Kopyalama yapar 

c-) Çift çizgi çizer               

d-) Çizgi üzerinde serbest biçimde nokta yakalar 

 

435.    Yandaki komutun adı nedir? 

a-) Snap To End      

b-) Snap To Quadrant      

c-) Snap To Extension     

d-) Snap To Node 

 

436.  Aşağıdakilerden hangisi yandaki komutun görevlerinden değildir? 

a-) Bir dosyanın layerlarını gösterir          

b-) Bir dosyanın ölçü stillerini gösterir 

c-) Bir dosyanın yazı stillerini gösterir      

d-) Bir dosyada çizilen çizimleri getirir 

 

437.   Yandaki düğme aşağıdaki komutlardan hangisinin özellilerini 

ekrana getirir? 

a-) Dimesion      

b-) Line      

c-) Circle      

d-) Text 

 

438.   Yandaki düğme aşağıdaki komutlardan hanginsin özellilerini 

ekrana getirir? 

a-) Line      

b-) Text      

c-) Dimesion      
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d-) Properties 

 

439.   Yandaki iki komutun isimleri sırasıyla aşağıdakilerden hangisidir? 

a-) Zoom dDynamic, Redo      

b-) Zoom All, Bold      

c-) Zoom Previous, Undo      

d-) Zoom Scale, Redo 

 

440.  Yandaki komuta hangi menüden ulaşabiliriz? 

a-) Format      

b-) Draw      

c-) Modify      

d-) Tools 

 

441.  Yandaki komutun görevi nedir? 

a-) Yardım dosyasını açar     

b-) Pencereyi kapatır      

c-) Dosyayı kapatır      

d-) Yanlış yapılan son işlemi geri alır. 

 

442.   Yandaki komutun adı nedir? 

a-) Enpoind      

b-) Midpoint      

c-) Intersection      

d-) Node 

 

443.  Yandaki komutun adı nedir? 

a-) Nearest      

b-) Intersection      

c-) Extension      

d-) Quadrant 

 

444.  Yandaki komutun görevi nedir? 
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a-) Dörtgenin köşe noktasını yakalar         

b-) Blok çizimleri taşıma noktasından yakalar 

c-) Nokta yakalar                                         

d-) Blok ekler 

 

445. Çizgiyi orta noktasından yakalayabilmek için osnap ayarlarından……………seçilir? 

a-) Enpoint      

b-) Midpoint      

c-) Node      

d-) Extension 

 

446.  Yandaki ölçülendirmeyi yapabilmek için 

hangi komut kullanılır. 

a-) Liner      

b-) Angular      

c-) Center      

d-) Baseline 

 

447.  Yandaki komutun görevi nedir? 

a-) Yazı ekler                                                               

b-) Ölçü çizgisine yazı ekler 

c-) Ölçü çizgilerindeki yazıların yerini değiştirir       

d-) Ölçü çizgilerine sembol ekler. 

 

448.   Sol resimde görülen bölümü ne amaçla kullanırız? 

a-) Yazı yazmayı sağlar                                                           

b-) Ölçü stilini değiştirmeyi sağlar 

c-) Bütün komutları girmemizi, işlem yapmamızı sağlar       

d-) Renk değiştirmeyi sağlar. 

 

449. Bloklanmış bir çizimi nasıl ayrı çizimlere dönüştürbiliriz? 

a-)  

b-)  
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c-)  

d-)  
 

450.  Yandaki düğmede hangisi kapatılırsa 

oluşturulan katman ekranda göründüğü halde silinemez? 

a-)  

b-)  

c-)  

d-)  
 

451.   Yandaki düğmeyle aşağıdaki değişikliklerden hangisini 

yapabiliriz? 

a-) Çizgilerin kalınlığını       

b-) Çizgilerin rengini       

c-) Çizgilerin tipini      

d-) Çizgilerin katmanlarını 

 

452.   Yandaki düğmelerin sırasıyla isimleri aşağıdakilerden 

hangisidir? 

a-) Open-Plot-New-Save      

b-) New-Open-Save-Plot      

c-) Plot-Save-Open-New      

d-) New-Open-Plot-Save 

 

453.  Yandaki komutun adı nedir? 

a-) Match properties      

b-) Paste      

c-) Plot preview      

d-) Properties 

 

454. Autocad dosyasının uzantısı nedir? 

a-) .xls      

b-) .doc     

c-) .dwg      
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d-) .dgw 

 

455.   Yandaki “Zoom” komutlarının isimleri sırasıyla hangi seçenekte 

verilmiştir? 

a-) Window-Dynamic-Scale-Center        

b-) Scale-Dynamic-In-Center 

c-) Dynamic-Windows-Out-All               

d-) Window-Dynamic-Extents-Object 

 

456.    Yandaki düğmenin görevi nedir? 

a-) Daire çizer                                            

b-) Dairenin radius ölçer 

c-) Dairenin merkez noktasını belirler      

d-) Daireye +  işareti ekler 

 

457.  Yandaki komutun adı aşağıdakilerden hangisidir? 

a-) Move      

b-) Offset     

c-) Mirror      

d-) Array 

 

458.  Render ayarları hangi butonla değiştirilebilir? 

a-)  

b-)  

c-)  

d-)  
 

459. Color Faces komutu ne işe yarar? 

a-) Çizgilerin kalınlığını değiştirmeye                                                 

b-) Elipslerin rengini değiştirmeye 

c-) Bir katının istediğimiz yüzeylerinin rengini değiştirmeye       

d-) Katıların çizgi rengini değiştirmeye 

 

460.  Aşağıdakilerden hangisi hesap makinasını açar? 
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a-)  

b-)  

c-)  

d-)  
 

461. Layout1 sayfası ne işe yarar? 

a-) Yeni bir dosya açar 

b-) Farklı açıları bir kâğıda yazdırma kolaylığı sağlar 

c-) Katılara desen vermeye yarar                    

d-) Yazıcının daha kaliteli basmasını sağlar  

 

462.   Komutunun adı nedir? 

a-) Mapping       

b-) Render      

c-) Materials      

d-) Landspace  

 

463. Ekranı birden fazla parçaya bölüp çizime çeşitli açılardan aynı anda bakmayı sağlayan 

View diyolog penceresine aşağıdaki yollardan hangisi ile ulaşabiliriz? 

a-) 3D View→SW Isometric      

b-) Viewports→New viewports 

c-) 3d View→SE Isometric        

d-) View → Clean Screen 

 

464. Aşağıdakilerden hangisi Yay uzunluğunu ölçmek için komuttur? 

a-) Radius       

b-) Angular       

c-) Tolerance        

d-) Arc Lenth 

 

465. Aşağıdakilerden hangisi önceden oluşturulmuş bloğu, gerektiğinde çizim sayfasına 

yüklemek için kullanılan komuttur? 

a-) Block      

b-) Make Block      

c-) Insert Block       
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d-) Save Block 

 

466. Aşağıdakilerden hangisi seçilen nesnelerin bloklanması için kullanılan komuttur? 

a-) Block      

b-) Description      

c-) Insert units      

d-) Object 

 

467.  Aşağıdakilerden hangisi Dimension Menüsündeki Tolerans komutunun içerisinde yer 

almaz? 

a-) Symbol      

b-) Material Condition      

c-) Datum Identifier      

d-) Dimension Style Manager 

 

 

468. Aşağıdakilerden hangisi komutları çalıştırma yöntemlerinden biri değildir? 

a-) Komutu çalıştıran simgeyi araç çubuğunda tıklamak 

b-) Komutun kısa yolunu komut satırına yazmak ve Enter tuşluna basmak 

c-) Komutun adını komut satırına yazmak ve boşluk tuşuna basmak 

d-) Komutun numarasını klavyeden girip Shift tuşuna basmak 

 

469. Aşağıdaki komutlardan hangisi çalıştırıldığında bir diyalog sayfası açılır? 

a-) Line 

b-) Layer 

c-) Ellipse 

d-) Scale 

 

470. Aşağıdakilerden hangisi bilgisayarda kayıtlı bir dosyayı açmak için kullanılır? 

a-) New 

b-) Save 

c-) Close 

d-) Open 

 

471. Aşağıdaki komutlardan hangisi Ctrl+C kısa yolu ile çalışır? 

a-) Copy 
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b-) Paste 

c-) Circle 

d-) Close 

 

472. Komut satırındaki “Select Objects” iletisi kullanıcının ne yapmasını 

istemektedir? 

a-) Değişiklikleri kaydetmesini 

b-) Objeleri saymasını 

c-) Objeleri seçmesini 

d-) Objeleri silmesini 

 

473. Circle komutunun hangi seçeneği ile iki objeye teğet ve yarıçapı verilerek daire 

çizilir? 

a-) Center/Radius 

b-) Center/Diameter 

c-) 3P 

d-) Ttr 

 

474. Offset komutu kullanılırken takip edilecek sıra aşağıdakilerden hangisidir? 

a-) Obje seçimi-Mesafe-Yön 

b-) Mesafe-Yön-Obje seçimi 

c-) Mesafe-Obje seçimi-Yön 

d-) Yön-Oje seçimi-Mesade 

 

475. Ekrandaki görüntünün büyüklüğünü değiştirmeden görüntüyü kaydırmak için 

kullanılan komut hangisidir? 

a-) Zoom Window 

b-) Pan Realtime 

c-) Regen 

d-) Zoom Extent 

 

476. Line komutundan çıkmak için aşağıdaki işlemlerden hangisi yapılmalıdır? 

a-) Fare ile çizim alanında her hangi bir nokta tıklanmalıdır 

b-) Bir sonraki noktanın koordinat değeri girilmelidir 

c-) Klavyeden ESC tuna basılmalıdır 

d-) Klavyeden F1 tuşuna basılmalıdır 
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477. Menü çubuğunda hangi komut bulunmaz? 

a-) Line 

b-) Edit 

c-) Dimension 

d-) File 

 

478. Klavyeden girilen komutları çalıştırmak için hangi tuş kullanılır? 

a-) Home 

b-) End 

c-) Del 

d-) Enter 

 

479. Serbest elle çizim yapan komut aşağıdakilerden hangisidir? 

a-) Mline 

b-) Spline 

c-) Sketch 

d-) Ellipse 

 

480. Area komutu aşağıdaki işlemlerden hangisini yapar? 

a-) Alan hesabı 

b-) Dairenin çapına + işareti koyar 

c-) Sekizgen çizer 

d-) Çoklu kopyalama yapar 

 

481. Kayıtlı bir dosyayı yeni bir isimle kaydetmek için hangi komut kullanılır 

a-) Plot 

b-) Close 

c-) Save As 

d-) New 

 

482. Zoom-Window komutunun görevi nedir? 

a-) Limits komutuyla ayarlanmış çizim limitlerini ekrana yerleştirmek 

b-) Pencere içine alınan bölgeyi ekranı kaplayacak şekilde büyütmek 
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c-) Çizimin tamamını ekranda görüntülemek 

d-) Çizimi yeni bir pencerede açmak 

 

I. Radius 

II. Multiple 

III. Previous 

483. Yukarıdakilerden hangileri Fillet komutunun içinde yer alan özel 

komutlardandır? 

a-) I. ve II.  

b-) II. ve III.  

c-) I. ve III.  

d-) Hepsi 

 

484. Hangisi yay çizme metotlarından değildir? 

a-) Center-Radius 

b-) Start-Center-Angle 

c-) 3 Points 

d-) Angle-Center-3 points 

 

I. Arc 

II. Undo 

III. Width 

IV. Redo 

485. Yukarıdaki seçeneklerden hangisi Polyline komutunun içinde yer alan 

komutlardan değildir? 

a-) I  

b-) II  

c-) III  

d-) IV 

 

486. Aşağıdaki simgelerden hangisi “Block Editor”ü açar? 

a-)  

b-)  

c-)  

d-)  
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487. Aşağıdaki simgelerden hangisi çizimi kaydetmek için kullanılır? 

a-)  

b-)  

c-)  

d-)  

 

488. Aşağıdakilerden hangisi seçilen çizginin panoya kopyalanmasında kullanılır? 

a-)  

b-)  

c-)  

d-)  

 

489. Aşağıdakilerden hangisi çıktı almak için kullanılır? 

a-)  

b-)  

c-)  

d-)  
490. Aşağıdakilerden hangisi çizime tablo eklemek için kullanılır? 

a-)  

b-)  

c-)  

d-)  
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I. Line 

II. Arc 

III. Ellipse 

491. Yukarıdakilerden hangisi polyline çizginin içinde yer alan alt komutlardandır? 

a-) I. ve III.     

b-) II. ve III.    

c-) I. ve II. 

d-) Hepsi 

 

492. Aşağıdakilerden hangisi sonsuz çizgiler (yardımcı doğrular) çizer? 

a-) Line 

b-) Polyline 

c-) Construction Lİne 

d-) Multi Line 

 

493. Aşağıdakilerden hangisi hızlı ölçülendirme yapmak için kullanılır? 

a-)  

b-)  

c-)  

d-)  

 

 

I. Mesafe girilip Enter tuşuna basılır 

II. Klavyeden L yazılıp Enter tuşuna basılır 

III. Fare yardımıyla çizginin oluşması istenilen yön izlenir 

IV. Çizginin başlaması istenilen nokta farenin sol tuşuyla tıklanır 

494. Yukarıda çizgi (Line) komutu kullanılırken yapılması gerekenler karışık olarak 

listelenmiştir. Doğru sıra aşağıdakilerden hangisi olmalıdır? 

a-) IV-II-I-III            

b-) II-IV-III-I         

c-) II-III-IV-I           

d-) I-II-III-IV 

 

 

I. Klavyeden C yazılıp Enter tuşuna basılır 
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II. Yarı çap ölçüsü klavyeden yazılıp Enter tuşuna basılır 

III. Daire merkezinin bulunması istenilen nokta farenin sol tuşu ile işaretlenir 

IV. Sırasıyla çap, açı ve alan ölçüleri yazılır 

495. Yukarıdakilerden hangisi Daire çizerken yapılan işlemlerden değildir? 

a-) I.      

b-) II.      
c-) III.      

d-) IV. 

 

 

496. Aşağıdakilerden yöntemlerden hangisiyle kapalı olan bir araç çubuğunu 

açabiliriz? 

a-) File menüsünden New komutunu çalıştırarak 

b-) Durum çubuğundan OTRACK a fareyle sağ tıklayıp settings seçeneğini tıklayarak 

c-) Farenin imleci ekrandaki herhangi bir araç çubuğunun üzerindeyken sağ tuşa 

tıklayarak 

d-) Tools menüsünden Drafting Settings komutunu çalıştırarak 

 

497. File menüsündeki “Exit” seçeneği ne amaçla kullanılır? 

a-) Programı kapatmaya 

b-) Programı kapatmadan üzerinde çalışılan dosyayı kapatmaya 

c-) Aktif komuttan işlem yapmadan çıkmaya 

d-) Bilgisayarı kapatmaya 

 

498. “Purge” komutu ne işe yarar? 

a-) Gereksiz yere çizilen çizgileri temizlemeye 

b-) Çizime resim dosyası eklemeye 

c-) Çizimde kullanılmayan katman, block, çizgi tipi, vb. tanımlamaları temizlemeye 

d-) Ekrandaki noktaları silmeye 

 

499. “Hatch” komutu hangi amaçla kullanılır? 

a-) Çizimleri gruplamaya 

b-) Tarama yapmaya 

c-) Çizime resim eklemeye 

d-) Çizgileri polyline hale getirmeye 
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500. Daire çizme komutunun klavye kısa yolu aşağıdakilerden hangisidir? 

a-) D       

b-) DA      

c-) Cİ     

d-) C 

 

501. İçi dolu küre çizmeyi sağlayan komutun simgesi aşağıdakilerden hangisidir? 

a-)  

b-)  

c-)  

d-)  

 

502. Özellikle iki boyutlu çizimlerde, çizim unsurlarını düzenlemek için kullanılan 

komutlar hangi menü altında toplanmıştır? 

a-) Draw    

b-) File    

c-) Modify 

d-) Help 

 

503. Çizimlere ölçülendirme yapmaya yarayan komutlar hangi menü altında 

toplanmıştır? 

a-) Draw    

b-) Dimension 

c-) File    

d-) Modify 

 

504. AutoCAD’e dair aşağıdakilerden hangisi doğrudur? 

a-) Çizim dosyalarının içerisine müzik eklemek için kullanılır 

b-) Resim dosyalarına rötuş ve montaj yapan bir programdır 

c-) Film dosyaları üzerinde oynama yapan bir programdır 

d-) Vektörel bir çizim programıdır 

 

505. Polar Array komutu hangi amaçla kullanılır? 
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a-) Seçilen objeleri, seçilen bir merkezin çevresinde döndürerek kopyalamak için 

b-) Seçilen objeleri, seçilen bir merkezin etrafında döndürmek için 

c-) Seçilen objeleri doğrusal bir istikamette kopyalamak için 

d-) Seçilen çizgilerin seçilen bir merkeze uzaklığını öğrenmek için 

 

506. Osnap komutu ile seçilen yakalama noktalarıyla ilgili aşağıdakilerden hangisi 

yanlıştır? 
a-) Tangent, teğet yakalar 

b-) Parallel, bir çizginin paralel açısını yakalar 

c-) End Point, çizgiyi orta noktasından yakalar 

d-) Center, dairenin merkez noktasını yakalar 

 

507. Aşağıdakilerden hangisi Draw araç çubuğunda bulunmaz? 

a-) Revision Cloud      

b-) Imprint      

c-) Spline      

d-) Point 

 

508. Aşağıdakilerden hangisi Modify araç çubunda bulunur? 

a-) 3D Rotate      

b-) Spline      

c-) Presspull      

d-) Explode 

 

509. Seçilen çizgiyi taşımak için kullanılan ……. komutu ………araç çubuğunda 

yer alır. 

a-) Move-Draw 

b-) Mirror-Modify      

c-) 3D Rotate-Modeling      

d-) Line-İnsert 

 

510. Köşelere pah kırmaya yarayan  ……. komutu …….. araç çubuğunda yer alır. 

a-) Chamfer-Draw      

b-) Chamfer-Modify 

c-) Circle-Draw       

http://www.cozumkariyer.com/


 
 

“ DOĞRU TERCİHLER SİZİ ÇÖZÜME GÖTÜRÜR “ 

Bizi Tercih  Ettiğiniz İçin  Teşekkür  Ederiz, Tüm  Kursiyerlerimize Sınavlarında Başarılar Dileriz.. 

İLETİŞİM :   0( 258) 265 57 52  -  241 75 15    -  0530  565 95 60 – 532 168 41 11       

www.cozumkariyer.com             

 

 

 

d-) Copy-Modify 

 

511. Aşağıdaki komut ve araç çubuğu eşleştirmelerinden hangisi doğrudur? 

a-) Circle-Modify      

b-) Strech-İnsert      

c-) Loft-Modeling     

d-) Tolerance-Layer 

 

512. Aşağıdakilerden hangisi Osnap Settings’te mevcuttur? 

a-) Vertex      

b-) Perpendicular      

c-) Pilot      

d-) Face 

 

513. Bir eksen etrafında dönerek dairesel formlarda katı oluşturan komut hangisidir? 

a-)  

b-)  

c-)  

d-)  

 

514. Hangisi iki katının kesişim noktası haricindekileri yok edip, sadece kesişen 

kısımlarından yeni bir model oluşturur? 

a-)  

b-)  

c-)  

d-)  

 

515.   Yandaki komutun adı nedir? 

http://www.cozumkariyer.com/


 
 

“ DOĞRU TERCİHLER SİZİ ÇÖZÜME GÖTÜRÜR “ 

Bizi Tercih  Ettiğiniz İçin  Teşekkür  Ederiz, Tüm  Kursiyerlerimize Sınavlarında Başarılar Dileriz.. 

İLETİŞİM :   0( 258) 265 57 52  -  241 75 15    -  0530  565 95 60 – 532 168 41 11       

www.cozumkariyer.com             

 

 

 

a-) Ellipse Arc      

b-) Arc      

c-) Rotate      

d-) Erase 

 

516.   Yandaki komutun görevi nedir? 

a-) Seçilen öğeyi panoya kopyalar 

b-) Çizime resim ekler 

c-) Çizime renk verir 

d-) Katı objelere desen verir 

 

517.  Yandaki simge hangi diyalog penceresini açar? 

a-) Dimension Style Menager 

b-) Table Style 

c-) Layer 

d-) Plot 

 

 

518. Aşağıdaki komut simgelerinden hangisi Modeling araç çubuğunda bulunur? 

a-)  

b-)  

c-)  

d-)  

 

519. Region komutunun kullanılabilmesi için aşağıdakilerden hangisine dikkat 

edilmesi gerekir? 

a-) Region oluşturulmak istenen çizimin uçlarının kapalı olması gerekir 

b-) Sadece Rectangle komutuyla çizilmiş çizimlerde kullanılır 
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c-) Dikkat edilecek bir durumu yoktur, her durumda çalışır 

d-) Sadece daire komutlarında çalışır. 

 

520. Aşağıdakilerden hangisi AutoCAD’in yapabileceklerinden birisi değildir? 

a-) Bina tasarımında kullanılabilir 

b-) Çizgi film animasyonları yapılabilir 

c-) Üç boyutlu tasarımlar yapılabilir 

d-) Makine üretim çizimlerinin oluşturulmasında kullanılabilir 

 

521. Trim komutunda düzenleme yaparken komuttan çıkmadan,“Extend” komutunu 

kullanabilmek için klavyeden hangi tuşa basılı tutmak gerekir. 

a-) Enter 

b-) Shift 

c-) ESC 

d-) Windows tuşu 

 

522. “CO” ve “CP” kısa yolları hangi komuta aittir? 

a-) Color      

b-) Circle      

c-) Copy      

d-) Desing Center 

 

I. Modify araç çubuğundan  simgesi tıklanır 

II. Uygulanması istenilen yarıçap yazılır, klavyeden Enter tuşuna basılır 

III. Klavyeden R tuşuna basılır 

IV. Yay çizilecek köşeyi oluşturan çizgiler sırası ile farenin sol tuşu yardımıyla 

tıklanır 

523. Yukarıda Fillet komutu kullanırken yapılması gerekenler karışık olarak 

verilmiştir. Doğru sıralama aşağıdakilerden hangisi olmalıdır? 

a-) I-II-IV-III      

b-) II-III-IV-I      

c-) III-I-II-IV      

d-) I-III-II-IV 

 

http://www.cozumkariyer.com/


 
 

“ DOĞRU TERCİHLER SİZİ ÇÖZÜME GÖTÜRÜR “ 

Bizi Tercih  Ettiğiniz İçin  Teşekkür  Ederiz, Tüm  Kursiyerlerimize Sınavlarında Başarılar Dileriz.. 

İLETİŞİM :   0( 258) 265 57 52  -  241 75 15    -  0530  565 95 60 – 532 168 41 11       

www.cozumkariyer.com             

 

 

 

524. Aşağıdakilerden hangisi AutoCAD’i başlatan masaüstü simgesidir? 

a-)  

b-)  

c-)  

d-)  

 

525. Aşağıdakilerden hangisi Daire komutunun içinde yer alan alt komutlardan 

değildir? 
a-) 3P       

b-) 2P      

c-) 1P      

d-) Ttr 

 

 

526.   Yandaki komut simgeleri hangi araç çubuğunda yer 

alır? 

a-) Modify  

b-) Draw  

c-) Dimension     

d-) Solid Editing 

 

 

527. XL” klavye kısa yolu hangi komutu çalıştırır? 

a-) Polyline  

b-) Multiline  

c-) Construction Line  

d-) Polygon 

 

528. “PR” klavye kısa yolu hangi diyalog penceresini açar? 

a-) Layer  

b-) Properties 
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c-) Table Style   

d-) Array 

 

529. Aşağıdakilerden hangisi “Modeling” araç çubuğu için söylenebilir? 

a-) İki boyutlu çizim komutlarını barındırır 

b-) Üç boyutlu katı modellerde düzenleme işlemleri gerçekleştiren komutları 

barındırır 

c-) Çizime dışarıdan obje getirmek için kullanılan komutları barındırır 

d-) Üç boyutlu model oluşturan komutları barındırır 

 

 

530. Workspaces araç çubuğu hangi amaçla kullanılır? 

a-) Koordinat tanımlamalarını değiştirmek için 

b-) Araç çubuklarını özelleştirmek için 

c-) Obje yakalama noktalarını belirlemek için 

d-) Çizgilerin katmanlarını değiştirmek için 

 

531. Materials diyalog penceresine hangi araç çubuğundan ulaşabiliriz? 

a-) Inquiry 

b-) UCS 

c-) Layouts 

d-) Render 

 

 

532. Ctrl+Z tuş kombinasyonunun görevi nedir? 

a-) En son yapılan değişikliği geri alır 

b-) Seçilen çizgiyi kırmızı renge boyar 

c-) Seçilen çizgiyi kopyalar 

d-) Önceden seçilip kopyalanmış çizgiyi çizim alanına yapıştırır 
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533.  Yandaki komutlar hangi araç çubuğunda yer alır? 

a-) Draw 

b-) Modify 

c-) Inquiry 

d-) Dimension 

 

534.  Yandaki komutların isimleri sırasıyla 

aşağıdakilerden hangisidir? 

a-) Copy-Offset-Mirror-Erase 

b-) Erase-Copy-Mirror-Offset 

c-) Mirror-Erase-Offset-Copy 

d-) Erase-Copy-Offset-Mirror 

 

535. Presspull komutu için aşağıdaki yazılanlardan hangisi yanlıştır? 

a-) Ctrl ve Alt tuşlarına aynı anda basılması durumunda devreye girer 

b-) 2 ve 3 boyutlu çizimlerde kullanılabilir 

c-) Çizimlere yükseklik kazandırabildiği gibi parça çıkartma işlemi de 

gerçekleştirebilir 

d-) Sadece Region çizimlere yükseklik kazandırabilir 

 

536. AutoCAD’te ışıklandırma işlemleri hangi araç çubuğu üzerin gerçekleştirilir? 

a-) Render 

b-) Web 

c-) Lights 

d-) Visual Styles 

 

 

 

 

 

 

 

 

 

http://www.cozumkariyer.com/


 
 

“ DOĞRU TERCİHLER SİZİ ÇÖZÜME GÖTÜRÜR “ 

Bizi Tercih  Ettiğiniz İçin  Teşekkür  Ederiz, Tüm  Kursiyerlerimize Sınavlarında Başarılar Dileriz.. 

İLETİŞİM :   0( 258) 265 57 52  -  241 75 15    -  0530  565 95 60 – 532 168 41 11       

www.cozumkariyer.com             

 

 

 

 

 

http://www.cozumkariyer.com/

